Table of Contents

Chapter 1: Getting Started ................................................................. 8
  Welcome ......................................................................................... 8
  Where to Find Information ............................................................. 8

Chapter 2: Hardware Features ......................................................... 9
  Front Panel Components ............................................................... 9
  Back Panel Components ............................................................... 10
  Bottom Edge Components ......................................................... 11
  USB Cradle .................................................................................. 11
  Temperature and Battery Life ..................................................... 11
    Recharging the Battery ............................................................ 12
    When Your Battery Is Low ....................................................... 13
  Optional Accessories ................................................................. 13
    SD and MMC Cards ..................................................................... 13
    Inserting or removing a memory card ...................................... 13
    External Battery .......................................................................... 13
    Attaching the External Battery ................................................ 14
    To view the current charge of the external battery ................. 14
  USB Cable ..................................................................................... 15
  Serial Cable ................................................................................... 15
  DC Connector ............................................................................... 15

Chapter 3: Knowing Your Pocket PC Phone ..................................... 16
  Resetting the Pocket PC Phone and Clearing Memory ............... 16
    To perform a soft reset ............................................................. 16
    To perform a full reset ........................................................... 16
  Backing Up Files .......................................................................... 17
    To save Word or Excel files to a memory card ....................... 17
    Back up or restore your system using SD Backup .................. 18
  Screen Tapping Calibration and Recalibration ......................... 18
    To recalibrate the screen ......................................................... 18
  Today Screen ............................................................................... 19
  Programs ....................................................................................... 20
  Navigation Bar and Command Bar ........................................... 21
  Pop-up Menus .............................................................................. 21
  Notifications ................................................................................ 21
  Entering Information on Your Pocket PC Phone .................... 22
    Entering Text Using the Input Panel ....................................... 22
    To type with the soft keyboard .............................................. 23
    To use Letter Recognizer ....................................................... 23
    To use Block Recognizer ....................................................... 24
    To switch to Transcriber ......................................................... 24
    To punctuate in Transcriber .................................................. 25
    To see how to write a letter in Transcriber ......................... 25
    To select typed text ............................................................... 26
    To edit text ............................................................................... 26
  Writing on the Screen ................................................................. 26
    To write on the screen ........................................................... 26
Chapter 4: Phone Features

About Your Phone

Installing the Smart Card
Removing the Smart Card
About The Dialer Screen
The Navigation Pad and Dialing
Entering Your PIN
Checking You Are Connected
Turning The Phone On and Off
To turn off the phone
To turn on the phone
Adjusting the Phone Volume
Back Spacing and Deleting
To back space over numbers
To delete the number

Basic Dialing Features

Making a call
To make a call from the Dialer
To make a call from Contacts
To make a call from Speed Dial (A)
To make a call from Speed Dial (B)
To make a call from the Call Log
To make a call from Phone Book
To send SMS in phone dialer
Enabling the Speakerphone Mode
Answering or Rejecting a Call ................................................................. 46
Ending a Call ......................................................................................... 47
Managing More Than One Call ............................................................. 47
Putting a Call on Hold ........................................................................... 47
To swap between calls .......................................................................... 48
To set up conference calling ................................................................. 48
Making a Note ......................................................................................... 49
To make a note ...................................................................................... 49
To view a note ....................................................................................... 50

Call Related Features................................................................................. 50
Checking Your Voice Mail ................................................................. 50
To retrieve your voice mail ................................................................. 50
Adding and Transferring Contact Information ..................................... 50
Places where contacts can enter your Pocket PC Phone and be stored ...... 50
Why transfer numbers? ........................................................................ 51
Microsoft Contacts: Adding and transferring contacts ....................... 51
Phone Book: Adding and transferring contacts .................................... 52
To create a Smart Card contact ......................................................... 52
To transfer contacts from Smart Card to Microsoft Contacts .............. 52
To transfer a number to Speed Dial .................................................... 53
To add a record to Microsoft Contacts from Call Log ....................... 53
Managing Your Call Log ...................................................................... 54
Viewing details of calls ........................................................................ 54
To view duration of call ....................................................................... 54
To delete individual calls from Call Log ............................................. 55
To delete all calls from Call Log ......................................................... 55
To set limits on the size of your Call Log ............................................. 55

Customizing Your Phone ..................................................................... 55
To select ring type and tone, and keypad sounds ................................. 55
Downloading Ring Tones ...................................................................... 56
To enable the PIN ................................................................................ 56
To change the PIN ............................................................................... 56
To enable Caller ID .............................................................................. 56
Call Forwarding .................................................................................... 57
To activate or deactivate Call Forwarding ........................................... 57
Call Waiting ......................................................................................... 57
To activate or deactivate Call Waiting ............................................... 58
Voice Mail and SMS ............................................................................ 58
To view your voice mail and SMS access numbers ............................ 58
To find a network ................................................................................ 59
To select a network ............................................................................. 59
To set preferred networks ................................................................. 60
To select automatic pickup ............................................................... 60
Using Key Lock ................................................................................... 61
To enable Key Lock ............................................................................ 61
Enabling Broadcast Channels ............................................................. 61
To enable Broadcast Channels ......................................................... 61

Additional Dialing Information ............................................................. 62
To make an emergency call ............................................................... 62
To make an international call ....................................................... 62
Chapter 5: Getting Connected ................................................................................ 63
Getting Help on Connecting.................................................................................... 63

Chapter 6: Wireless Data Programs ...................................................................... 64
Pocket Internet Explorer: Browsing Web and WAP pages ...................................... 64
Using Pocket Internet Explorer ................................................................................ 65
To view Mobile Favorites and Channels ................................................................. 65
To browse the Internet ............................................................................................ 65
The Mobile Favorites Folder ..................................................................................... 66
Favorite Links ............................................................................................................ 66
Mobile Favorites ......................................................................................................... 66
To create a Mobile Favorite ....................................................................................... 66
Saving Pocket PC Phone Memory ............................................................................ 66
To browse the Internet ............................................................................................ 67
Using AvantGo Channels ......................................................................................... 67
To sign up for AvantGo ............................................................................................. 67

MSN Messenger: Instant Messaging ...................................................................... 67
To switch to MSN Messenger .................................................................................. 67
Setting Up An Account ............................................................................................. 68
Working with Contacts ............................................................................................ 68
Chatting with Contacts ............................................................................................ 69

Inbox: Sending and Receiving E-mail or SMS ......................................................... 69
Synchronizing E-mail Messages ............................................................................... 70
Connecting Directly to an E-mail Server .................................................................. 70
Using the Message List ............................................................................................ 70
Creating an SMS text message or E-mail ............................................................... 72
Managing Messages and Folders .............................................................................. 72
Folder behavior with a direct connection to an e-mail server .................................. 72
Transferring Items Using Infrared ............................................................................ 73
To send information ................................................................................................. 73
To receive information ............................................................................................. 73

Terminal Services Client ......................................................................................... 73
To connect to a Terminal Server .............................................................................. 73
To disconnect without ending a session .................................................................... 74
To disconnect and end a session .............................................................................. 74
To navigate within Terminal Services Client .......................................................... 74
To improve display performance ............................................................................. 74
To improve browser performance ............................................................................ 74

Chapter 7: Microsoft ActiveSync ......................................................................... 75
Synchronizing Files ................................................................................................. 76
To synchronize files ................................................................................................ 76

Chapter 8: Microsoft Pocket Outlook ..................................................................... 77
Calendar: Scheduling Appointments and Meetings ............................................... 77
To create an appointment ....................................................................................... 78
Using the Summary Screen ........................................................................................................ 78
Creating Meeting Requests ........................................................................................................ 78
To schedule a meeting .................................................................................................................. 79

Contacts: Tracking Friends and Colleagues .......................................................................... 79
To create a contact ...................................................................................................................... 80
To find a contact ......................................................................................................................... 80
Using the Summary Screen ........................................................................................................ 81

Tasks: Keeping a To Do List ..................................................................................................... 81
To create a task .............................................................................................................................. 82
Using the Summary Screen ........................................................................................................ 82

Notes: Capturing Thoughts and Ideas .................................................................................... 83
To create a note ............................................................................................................................. 83

Chapter 9: Companion Programs ........................................................................................... 84

Pocket Word ................................................................................................................................ 84
Typing Mode ................................................................................................................................. 85
Writing Mode ................................................................................................................................. 85
Drawing Mode ............................................................................................................................... 86
Recording Mode ........................................................................................................................... 86

Pocket Excel .................................................................................................................................. 86
Tips for Working in Pocket Excel ............................................................................................... 87

Windows Media Player for Pocket PC Phone ........................................................................... 87

Microsoft Reader ......................................................................................................................... 88
Getting Books on Your Pocket PC Phone .................................................................................... 89
Using the Library .......................................................................................................................... 89
Reading a Book ............................................................................................................................ 90
Using Reader Features .................................................................................................................. 90
Removing a Book .......................................................................................................................... 91

Image Viewer ................................................................................................................................ 91
Transferring Images to your Pocket PC Phone ........................................................................... 91
Changing your Image List Layout ............................................................................................... 91
Viewing Images ............................................................................................................................ 92
Deleting an Image .......................................................................................................................... 92
Refreshing All Images .................................................................................................................. 92
Arranging Order ............................................................................................................................ 92

Appendix A: Character Recognizer .......................................................................................... 93

Appendix B: Troubleshooting .................................................................................................... 94
Reseting the Pocket PC Phone and Clearing Memory .............................................................. 94
To perform a soft reset .................................................................................................................. 94
To perform a full reset ................................................................................................................... 94
Battery loses power ....................................................................................................................... 95
Use external power whenever possible ................................................................. 95
Shorten auto suspend time ..................................................................................... 95
To turn off sounds you do not need ....................................................................... 95
To turn off notification light .................................................................................... 95
If you forget your password .................................................................................... 95
If you run out of phone memory ............................................................................. 95
Finding Space in Storage Memory .......................................................................... 95
Finding Space in Program Memory .......................................................................... 96
Screen freezes or responds slowly ......................................................................... 96
Screen is blank .......................................................................................................... 96
Screen is dark ........................................................................................................... 96
Screen is hard to read ............................................................................................... 96
Inaccurate response to stylus taps .......................................................................... 97
Slow or no response ................................................................................................. 97
Infrared (IR) connection problems ......................................................................... 97
Phone connection problems ................................................................................... 97
Internet connection problems ................................................................................ 97
Network connection problems ................................................................................ 97
Cable and cradle connection problems .................................................................. 98

Appendix C: Regulatory Notices ........................................................................... 99
Regulatory Agency Identification Numbers ......................................................... 99
European Union Notice ........................................................................................ 99
Important Safety Information ............................................................................... 100
General Precautions ............................................................................................ 100
Safety Precautions for Power Supply Unit ......................................................... 100

Appendix D: Hardware Specifications ................................................................... 101

Appendix E: Icons ............................................................................................... 102
Phone ..................................................................................................................... 102
Pocket PC ............................................................................................................. 103

Copyright Information
Microsoft, ActiveSync, Outlook, Pocket Outlook, Windows, Windows NT, and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Microsoft products are licensed to OEMs by Microsoft Licensing, Inc., a wholly owned subsidiary of Microsoft Corporation.
Chapter 1: Getting Started

Welcome

Congratulations on purchasing a Pocket PC Phone. The integrated wireless voice and data capabilities mean that as well as keeping your important Personal Information Manager (PIM) information up-to-date and close at hand, you can make calls, send and receive e-mail, and look up valuable information from the Internet or your company’s network anytime, anywhere. Also, with Microsoft ActiveSync, the power of your Pocket PC Phone is increased by allowing you to synchronize the information on your PC with your Pocket PC Phone. Picture yourself in the following situations:

- While walking with a colleague, your Pocket PC Phone rings. You look at the caller ID and see your manager is calling. She asks if you two are free this afternoon for an emergency meeting. While your colleague fumbles through his paper organizer, you press a button on your Pocket PC Phone and instantly see a list of today’s appointments and meetings. You are quickly able to tell your manager your available times, and make a note of the new meeting while on the call. You hang up and send e-mail with a meeting request for the three of you at the desired location.
- You are meeting your friends tonight for dinner and a movie. You download the latest movie information from the Internet to your PC, and then synchronize it with your Pocket PC Phone. At dinner, you pull out your Pocket PC Phone and review your movie options with your friends. A Calendar reminder alerts you that it is time to see the movie. You grab your Pocket PC Phone, check driving directions and head towards the theater.
- Because ActiveSync keeps the information on your Pocket PC Phone up-to-date, you can leisurely review your current task list, make notes on the new books and DVDs you want to buy, and read and respond to e-mail messages quickly and conveniently. When you get back to the office, ActiveSync transfers any task changes you made - new notes, responses to e-mails, etc. – directly to your PC.

Where to Find Information

This User Manual describes your Pocket PC Phone hardware, provides an overview of the programs on your Pocket PC Phone, and explains how to connect your Pocket PC Phone to a PC, to a network or to the Internet. For instructions on setting up your Pocket PC Phone, see the Quick Start Guide, the Welcome Guide and the Product Tour video on the enclosed Pocket PC Phone Companion CD. The following table is a guide to additional information to help you use your Pocket PC Phone.

<table>
<thead>
<tr>
<th>For information on:</th>
<th>See this source:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programs on your Pocket PC Phone</td>
<td>This User Manual and Pocket PC Phone Help. To view Help, tap Help and then Help.</td>
</tr>
<tr>
<td>Additional programs that can be installed on the</td>
<td>The Pocket PC Phone Companion CD.</td>
</tr>
<tr>
<td>Pocket PC Phone</td>
<td></td>
</tr>
<tr>
<td>Connecting to and synchronizing with a PC</td>
<td>The Quick Start Guide or ActiveSync Help on your Pocket PC Phone. To view ActiveSync Help, click Help and then Connections.</td>
</tr>
<tr>
<td>Last-minute updates and detailed technical</td>
<td>The Read Me files, located in the Microsoft ActiveSync folder on the PC and on the Pocket PC Phone Companion CD.</td>
</tr>
<tr>
<td>information</td>
<td></td>
</tr>
<tr>
<td>Up-to-date information on your Pocket PC Phone</td>
<td><a href="http://www.pocketpc.com">http://www.pocketpc.com</a></td>
</tr>
</tbody>
</table>
Chapter 2: Hardware Features

Your Pocket PC Phone has hardware buttons and a stylus for selecting items and entering information.

Front Panel Components

1. Volume. Press to adjust the volume of your Pocket PC Phone.
2. Infrared Port. Enables you to exchange file(s) or data with other Pocket PC Phones without cables/wires.
3. Power Button. Press to turn on/off your Pocket PC Phone.
   Backlight. Press and hold to turn the backlight on/off.
4. Contacts. Press for quick access to your Contacts.
5. Speaker. Listen to audio media or a phone call from here.
6. Notification LED:
   a) Flashing Green (Every 3 seconds) – GSM Network Signal.
   b) Flashing Green (Every second) – Notification Alarm Reminder.
   c) Steady Red – Battery empty.
   d) Flashing Red – Low battery.
   e) Steady Amber – Battery charging.
   f) Steady Green – Fully charged.
7. Calendar. Press to quickly access the Calendar.
8. End. Press to end a call.
   Phone On/Off. Press and hold to turn on/off your Pocket PC Phone’s phone.
9 **Navigation Pad:** Allows you to move up/down and left/right through any of the drop-down menus or program instructions; select by pressing in the center.
- **Left:** When in the Dialer screen, press once to access the Speed Dial feature.
- **Right:** When in the Dialer screen, press once to access the Call Log feature.

10 **Microphone.** Speak into the microphone when receiving/making a phone call or voice recording.

11 **Take Call.** Press to take an incoming call.
- **Dialer Screen.** Press to activate the dialer screen.
- **Speakerphone.** Press and hold to turn on/off the speakerphone.
- **Dial.** Press to dial a number.

12 **Touch Screen.** Use the touch screen to write, draw or make a selection with the stylus.

### Back Panel Components

1. **Smart Card Door.** Open the rubber door to insert the Smart Card.
2. **Stylus Slot and Stylus.** The antenna has a neatly hidden slot for housing the stylus.
3. **To Secure External Battery.** The optional External Battery should be fastened here. (See the section, *Attaching the External Battery*)
4. **External Battery Connector Cover.** Remove this to uncover the connection between your Pocket PC Phone and the optional External Battery.
5. **Main Battery Unit.** The main battery is housed permanently inside the Pocket PC Phone – it should only be changed through an authorized sales center.
6. **External Battery Clip.** Before screwing the External Battery into position, secure the clip on the bottom into this hole.
Bottom Edge Components

1. **Soft Reset.** Press into the hole with the end of your stylus to reset your Pocket PC Phone.
2. **Sync Connector.** Use this connector when synchronizing/transmitting data or when recharging.
3. **Earphone Jack.** Use the earphone jack or the phone’s hands-free kit to listen to audio media.
4. **Battery On/Off Switch.** Press into the hole with the end of the top-half of your stylus to return the Pocket PC Phone to factory settings.
   - **CAUTION:** Battery Off will wipe all the data from your Pocket PC Phone!
5. **MMC And SD Card Slot.** Insert either MMC or SD cards in this slot.

USB Cradle

- Your Pocket PC Phone comes with a USB cradle. This allows you to recharge your Pocket PC Phone, as well as synchronize information between your Pocket PC Phone and a PC using ActiveSync.
- To synchronize, plug the USB cradle into an available USB port on your PC.

Temperature and Battery Life

Your Pocket PC Phone contains a rechargeable Lithium Polymer battery, which is housed permanently in your Pocket PC Phone. After a few years of continual use and recharging the battery will become unusable and should be changed through a service center. While you are using your Pocket PC Phone the amount of power consumed depends on whether you are talking on the phone, using the PIM and Internet functions or the Pocket PC Phone is on standby. The estimates for battery life (talk time: 4–5 hours, PIM: 15–17 hours and standby: 150–170 hours) are based on only using one function. Since you will be continually swapping between functions, these estimates will vary.
Your Pocket PC Phone contains a Lithium Polymer battery pack. There is a risk of fire and burns if the battery pack is handled improperly. Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water. Do not attempt to open or service the battery pack. Replace only with the battery pack designated for this product. Dispose of batteries properly.

**Recharging the Battery**

Remembering to charge your battery is extremely important, as your Pocket PC Phone does not have a hard drive. All your data and any new programs you install are stored in Random Access Memory (RAM). In the event that the battery loses all its power, personal data and newly installed software programs will be wiped off. Only the default programs installed when you bought the Pocket PC Phone will remain. You can recharge your Pocket PC Phone in the following ways:

- Place your Pocket PC Phone in the cradle and connect the cradle to an external power source. The first time you use it initially charge for three to four hours. Then place your Pocket PC Phone in the cradle for a short time each day to recharge to its full capacity.

- You can plug the AC adapter into the optional USB/Serial cable head and then connect your Pocket PC Phone directly to an external power source.
To your Pocket PC Phone    To AC adapter

- You can plug the AC adapter into the optional DC Converter and then connect your Pocket PC Phone directly to an external power source.

When Your Battery Is Low
Your Pocket PC Phone has only one battery; however, a portion of that battery is saved as backup. If the battery gets very low, your Pocket PC Phone displays a warning message. If this occurs, save any unsaved data you are working on, perform synchronization with your PC and then turn off your Pocket PC Phone. Do not try to restart your Pocket PC Phone until you have connected to external power. If your Pocket PC Phone does shut down, the backup portion of your battery will protect your data for approximately 72 hours.

Optional Accessories
SD and MMC Cards
Your Pocket PC Phone has an expansion slot compatible with a range of SD and MMC memory cards, which are primarily used to back up or transfer files and data.

Inserting or removing a memory card

1. Push the memory card into the bottom slot until it clicks into place. The card is secure when it is not protruding from the base.

External Battery
You can purchase an optional External Battery to increase the battery life of your Pocket PC Phone by up to another 4 hours, and standby time by another 150 hours. The External Battery can be charged with either your Pocket PC Phone or with an External Battery charger. Charging with the External Battery charger should take about two and a half hours; when it is attached to the Pocket PC Phone, total charging for the External Battery and Pocket PC Phone should be approximately five hours.
Attaching the External Battery

1. Remove the rubber cap protecting the Pocket PC Phone connector for the External Battery. The cap is situated just below the right screw on the back of the Pocket PC Phone.

2. Hook the External Battery into the embedded slot near the base of the back of your Pocket PC Phone (see picture to the left).

3. Tighten the screws at the top of the External Battery into your Pocket PC Phone.

To view the current charge of the external battery

When you attach the External Battery an extra indicator will be added to the Power screen.

To view this indicator tap Start, Settings, System and then Power.

Your Pocket PC Phone contains a Lithium Polymer battery pack. There is a risk of fire and burns if the battery pack is handled improperly. Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water. Do not attempt to open or service the battery pack. Replace only with the battery pack designated for this product. Dispose of batteries properly.
USB Cable

- The USB cable allows you to synchronize with your desktop PC without the cradle. The DC converter in the head also allows you, in combination with an AC adapter, to recharge your Pocket PC Phone.

Serial Cable

- The Serial cable allows you to synchronize with your desktop PC without the cradle. The DC converter in the head also allows you, in combination with an AC adapter, to recharge your Pocket PC Phone.

DC Connector

- The DC connector, in combination with the AC adapter, allows you to recharge your Pocket PC Phone without the cradle.
Chapter 3: Knowing Your Pocket PC Phone

Resetting the Pocket PC Phone and Clearing Memory

You can perform a soft reset or a full reset – a soft reset restarts your Pocket PC Phone and a full reset switches the battery off. The result of a soft reset is that some data may be lost in programs that are open. The result of a full reset is wiping all the data and new programs you have added - and returning the Pocket PC Phone to factory settings – which will only have the software that was present when you bought it. Therefore, it is important not to think about a full reset as you would restarting, shutting down or even switching off your desktop PC, but rather like a complete crash requiring you to wipe your operating system (OS). The importance of backing up data to an SD card or your computer cannot be stressed enough - in the event you have to perform a full reset your data will not be lost.

To perform a soft reset

If your Pocket PC Phone responds slowly, stops responding or freezes, try soft resetting it. A soft reset causes the Pocket PC Phone to restart and re-adjust memory allocation. Unsaved data in open windows may be lost.

- Use the stylus to press and hold the Reset button for about two seconds. (For details on finding soft reset, see “Chapter 2, Bottom Edge Components.”)

To perform a full reset

Clearing memory deletes all data and restores the Pocket PC Phone to its default settings. Programs installed at the factory remain, while data you have created and programs you have installed are erased.

1. Unscrew the stylus and use the smaller point of the top-half.
2. Press the battery switch once to turn it off, and then once more to turn it back on.

Backing Up Files

Because any new programs or data are stored in RAM and will be lost if you have to perform a full reset, or your Pocket PC Phone loses all power for any other reason, it is absolutely paramount that you back up files to your computer or a memory card. When you are at your desktop PC you can synchronize with your computer to back up files. However, if you are unable to access your desktop PC, you will need to back up files to a SD or MMC card. In this case, you can back up individual files in Word or Excel or all files in SD backup.

To save Word or Excel files to a memory card

1. In application programs (e.g. Pocket Word or Excel) press **Tools, Options**.

2. Tap the drop-down menu box under **Save To** and select **Storage Card**.
Back up or restore your system using SD Backup

1. Push the memory card into the slot until it clicks into place (see Chapter 2, “Inserting or removing a memory card”). The card is secure when it is not protruding from the base.

2. Tap Programs, (SD Backup) then the Backup or Restore tab.

3. Tap Open, Storage Card.

4. Make sure there are no application programs running in the background, and then tap Start.

Screen Tapping Calibration and Recalibration

When you first start up your Pocket PC Phone, you will be asked to calibrate the screen by tapping the center of a cross with your stylus as it moves around the screen. This process ensures when you tap the screen with your stylus the item tapped is activated. If you are using your Pocket PC Phone and you discover tapping an item does not bring up the appropriate response, your Pocket PC Phone has lost its calibration.

To recalibrate the screen

- Tap Settings, System and then Screen.
- As described above, tap the center of the cross to with your stylus as it moves around the screen.
- Tap. Touch the screen once with the stylus to open items and select options.
- Drag. Hold the stylus on the screen and drag across the screen to select text and images. Drag in a list to select multiple items.
- Tap and hold. Tap and hold the stylus on an item to see a list of actions available for that item. On the pop-up menu that appears, tap the action you want to perform.
Today Screen

When you turn on your Pocket PC Phone for the first time each day (or after 4 hours of inactivity), you will see the Today screen. You can also display it by tapping and then Today. On the Today screen, you can see at glance important information for the day.

Following are some of the status icons you may see.

- 
  Turns all sounds on and off

- 
  Main battery low

- 
  Main battery very low

- 
  Connection is active

- 
  Synchronization is beginning or ending

- 
  Synchronization is in progress

- 
  Notification that one or more instant messages were received

- 
  Notification that one or more e-mail/SMS messages were received

- 
  Shows the connection to your mobile phone service provider is on and the strength of the signal

- 
  Indicates your phone is switched off

If more notification icons need to be displayed than there is room to display them, the Notification icon will display. Tap this icon to view all notification icons.
Programs

You can switch from one program to another by selecting it from the Programs menu. You can customize which programs you see on this menu. For information, see “Adjusting Settings” later in this chapter. To access some programs, you will need to tap Programs, and then the program name.

You can also switch to some programs by pressing a program button. Your Pocket PC Phone has one or more program buttons located on the front or side of the Pocket PC Phone. The icons on the buttons identify the programs they switch to.

Some programs have abbreviated labels for check boxes and drop-down menus. To see the full spelling of an abbreviated label, tap and hold the stylus on the label. Drag the stylus off the label so that the command is not carried out.

The following table contains a partial list of programs that are on your Pocket PC Phone. Look on the Pocket PC Phone Companion CD for additional programs that you can install on your Pocket PC Phone.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ActiveSync</td>
<td>Synchronize information between your Pocket PC Phone and PC.</td>
</tr>
<tr>
<td></td>
<td>Calendar</td>
<td>Keep track of your appointments and create meeting requests.</td>
</tr>
<tr>
<td></td>
<td>Contacts</td>
<td>Keep track of your friends and colleagues.</td>
</tr>
<tr>
<td></td>
<td>Inbox</td>
<td>Send and receive e-mail/SMS messages.</td>
</tr>
<tr>
<td></td>
<td>Pocket Internet Explorer</td>
<td>Browse Web and WAP sites, and download new programs and files from the Internet.</td>
</tr>
<tr>
<td></td>
<td>Notes</td>
<td>Create handwritten or typed notes, drawings, and recordings.</td>
</tr>
<tr>
<td></td>
<td>Tasks</td>
<td>Keep track of your tasks.</td>
</tr>
<tr>
<td></td>
<td>Pocket Excel</td>
<td>Create new workbooks or view and edit Excel workbooks.</td>
</tr>
<tr>
<td></td>
<td>MSN Messenger</td>
<td>Send and receive instant messages with your MSN Messenger contacts.</td>
</tr>
<tr>
<td></td>
<td>Pocket Word</td>
<td>Create new documents or view and edit MS-Word documents.</td>
</tr>
<tr>
<td></td>
<td>Phone</td>
<td>Make and receive calls, swap between calls and set up conference calling.</td>
</tr>
<tr>
<td></td>
<td>SD Backup</td>
<td>Back up your Pocket PC Phone files to a SD card.</td>
</tr>
<tr>
<td></td>
<td>Phone Book</td>
<td>Loads contents of your Smart Card to your Pocket PC Phone and allows you to transfer to Contacts.</td>
</tr>
<tr>
<td></td>
<td>Windows Media Player</td>
<td>To enable the multimedia function on your Pocket PC Phone.</td>
</tr>
</tbody>
</table>
Navigation Bar and Command Bar

• The navigation bar is located at the top of the screen. It displays the active program and current time, and allows you to switch to programs and close screens.

• Use the command bar at the bottom of the screen to perform tasks in programs. The command bar includes menu names, buttons, and the Input Panel button. To create a new item in the current program, tap New. To see the name of a button, tap and hold the stylus on the button. Drag the stylus off the button so that the command is not carried out.

Pop-up Menus

With pop-up menus, you can quickly choose an action for an item. For example, you can use the pop-up menu in the contact list to quickly delete a contact, make a copy of a contact, or send an e-mail message to a contact. The actions in the pop-up menus vary from program to program. To access a pop-up menu, tap and hold the stylus on the item name that you want to perform the action on. When the menu appears, lift the stylus and tap the action you want to perform. Or tap anywhere outside the menu to close the menu without performing an action.

Notifications

Your Pocket PC Phone reminds you in a variety of ways when you have something to do or you receive an SMS. For example, if you have set up an appointment in Calendar, a task with a due date in Tasks, or an alarm in Clock, you will be notified in any of the following ways:

• A message box appears on the screen.
• A sound, which you can specify, is played.
• A light flashes on your Pocket PC Phone.
• The Pocket PC Phone vibrates.

To choose reminder types and sounds for your Pocket PC Phone, tap and then Settings. In the Personal tab, tap Sounds & Notifications. The options you choose here apply throughout the Pocket PC Phone.

**Entering Information on Your Pocket PC Phone**

You have several options for entering new information:

• Use the input panel to enter typed text, either by using the soft keyboard or other input method.
• Write directly on the screen.
• Draw pictures on the screen.
• Speak into your Pocket PC Phone microphone to record a message.
• Use Microsoft ActiveSync to synchronize or copy information from your PC to your Pocket PC Phone. For more information on ActiveSync, see ActiveSync Help on your desktop PC.

**Entering Text Using the Input Panel**

• Use the input panel to enter information in any program on your Pocket PC Phone. You can either type using the soft keyboard or write using Letter Recognizer, Block Recognizer, or Transcriber. In all cases, the characters appear as typed text on the screen.
• To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the Input Panel button to see your choices.
• When you use the input panel, your Pocket PC Phone anticipates the word you are typing or writing and displays it above the input panel. When you tap the displayed word, it is inserted into your text at the insertion point. The more you use your Pocket PC Phone, the more words it learns to anticipate.
To type with the soft keyboard

1. Tap the arrow next to the Input Panel button and then **Keyboard**.
2. On the soft keyboard that is displayed, tap the key with your stylus.

To use Letter Recognizer

With Letter Recognizer you can write letters using the stylus just as you would on paper.

1. Tap the arrow next to the Input Panel button and then **Letter Recognizer**.
2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Letter Recognizer, with Letter Recognizer open, tap the question mark next to the writing area.
To use Block Recognizer

With Block Recognizer you can input character strokes using the stylus that are similar to those used on other Pocket PC Phones.

1. Tap the arrow next to the Input Panel button and then **Block Recognizer**.
2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Block Recognizer, with Block Recognizer open, tap the question mark next to the writing area.

To switch to Transcriber

With Transcriber you can write anywhere on the screen using the stylus just as you would on paper. Unlike Letter Recognizer and Block Recognizer, you can write a sentence or more of information. Then, pause and let Transcriber change the written characters to typed characters.

1. Tap the arrow next to the Input Panel button and then **Transcriber**.
2. Write anywhere on the screen.

For specific instructions on using Transcriber, with Transcriber open, tap the question mark in the lower right hand corner of the screen.
To punctuate in Transcriber

1. Tap the keyboard on the toolbar.
2. Tap OK to hide the keyboard.

Click on a letter for a demonstration.

To see how to write a letter in Transcriber

1. Tap “a” on the toolbar.
2. In the screen that appears, select the letter you want to learn about, and then tap on one of the examples given above.

For specific instructions on using Transcriber, with Transcriber open, tap the question mark in the lower right hand corner of the screen.

Click on a letter for a demonstration
To select typed text

If you want to edit or format typed text, you must select it first. To do so:

- Drag the stylus across the text you want to select. You can cut, copy, and paste text by tapping and holding the selected words and then tapping an editing command on the pop-up menu, or by tapping the command on the Edit menu.

To change word suggestion options, such as the number of words suggested at one time, tap Settings, Personal tab, Input, and then the Word Completion tab.

To edit text

Each input program provides cursor keys to move through text and backspace so that you can correct spelling, grammar or insert additional information. You can also use your stylus to make an insert. After you have made an insert, you can use any of the input methods described above to add additional text at the insertion point.

Writing on the Screen

In any program that accepts writing, such as the Notes program, and in the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus to write directly on the screen. Write the way you do on paper. You can edit and format what you have written and convert the information to text at a later time.

To write on the screen

- Tap the Pen button to switch to writing mode. This action displays lines on the screen to help you write.
Some programs that accept writing may not have the Pen button. See the documentation for that program to find out how to switch to writing mode.

To select writing

If you want to edit or format writing, you must select it first.

1. Tap and hold the stylus next to the text you want to select until the insertion point appears.

2. Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try again. You can also select text by tapping the Pen button to deselect it and then dragging the stylus across the screen.

You can cut, copy and paste written text in the same way you work with typed text: tap and hold the selected words and then tap an editing command on the pop-up menu, or tap the command on the Edit menu.

To convert writing to text

1. Tap Tools and then Recognize.

2. If you want to convert only certain words, select them before tapping Recognize on the Tools menu (or tap and hold the selected words and then tap Recognize on the pop-up menu). If a word is not recognized, it is left as writing.

3. If the conversion is incorrect, you can select different words from a list of alternates or return to the original writing. To do so, tap and hold the incorrect word (tap one word at a time). On the pop-up menu, tap Alternates. A menu with a list of alternate words appears. Tap the word you want to use, or tap the writing at the top of the menu to return to the original writing.

Tips for getting good recognition

1. Write neatly.

2. Write on the lines and draw the end of lowercase letters (y, g, p) below the line. Write the cross of the “t” and apostrophes below the top line so that they are not confused with the word above. Write periods and commas above the line.

3. For better recognition, try increasing the zoom level to 300% using the Tools menu.

4. Write the letters of a word closely and leave big gaps between words so that the Pocket PC Phone can easily tell...
where words begin and end.

5. Hyphenated words, foreign words that use special characters such as accents, and some punctuation cannot be converted.

6. If you change a word or number (such as changing a “3” to an “8”) after you attempt to recognize it, the writing you add will not be included if you attempt to recognize the writing again.

Drawing on the Screen

You can draw on the screen in the same way that you write on the screen. The difference between writing and drawing on the screen is how you select items and how they can be edited. For example, selected drawings can be resized, while writing cannot.

To create a drawing

- Cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or touching the drawing box become part of the drawing. Drawings that do not cross three ruled lines will be treated as writing.

To select a drawing

If you want to edit or format a drawing, you must select it first.

- Tap and hold the stylus on the drawing until the selection handle appears. To select multiple drawings, deselect the Pen button and then drag to select the drawings you want.

- You can cut, copy and paste selected drawings by tapping and holding the selected drawing and then tapping an editing command on the pop-up menu, or by tapping the command on the Edit menu. To resize a drawing, make sure the Pen button is not selected, and drag a selection handle.

You may want to change the zoom level so that you can more easily work on or view your drawing. Tap Tools and then a zoom level.
Recording a Message

In any program where you can write or draw on the screen, you can also quickly capture thoughts, reminders, and phone numbers by recording a message. In Calendar, Tasks, and Contacts, you can include a recording in the Notes tab. In the Notes program, you can either create a stand-alone recording or include a recording in a written note. If you want to include the recording in a note, open the note first. In the Inbox program, you can add a recording to an e-mail message.

To create a recording

1. Hold your Pocket PC Phone’s microphone near your mouth or other source of sound.
2. Tap Notes and then Notes.
3. Tap to make your recording. A beep will sound in the beginning of the recording.
4. Tap to stop recording. Two beeps will sound. The new recording appears in the note list or as an embedded icon.

You can also make a recording by tapping the Record button on the Recording toolbar.

Using My Text

- When using Inbox or MSN Messenger, use My Text to quickly insert preset or frequently used messages into the text entry area. To insert a message, tap My Text and tap a message.
- To edit a My Text message, in the Tools menu, tap Edit and then tap My Text Messages. Select the message you wish to edit and make desired changes.

You can add text to a My Text message after inserting it.
Finding and Organizing Information

The Find feature on your Pocket PC Phone helps you quickly locate information.

- On the menu, tap **Find**. Enter the text you want to find, select a data **Type**, and then tap **Go** to start the search.

To quickly find information that is taking up storage space on your Pocket PC Phone, select **Larger than 64 KB** in **Type**.

- Tap in a file name, select a file type and press **Go**.
- The name of the file will appear in the box entitled **Results**.
Managing Memory

Memory on your Pocket PC Phone is shared between storage memory and program memory. Storage memory is used to store the information you create and programs you install. Program memory is used to run programs on your Pocket PC Phone. The Pocket PC Phone automatically manages the allocation between storage and program memory.

To view memory allocation and availability

Tap Settings, System and then Memory.

Finding Space in Storage Memory

In some situations, such as when memory is low, your Pocket PC Phone may not be able to automatically adjust the allocation. If you receive a message stating that storage or program memory is unavailable, try the following solutions.

To make available storage memory

1. Move data to a SD storage card.

2. Tap Programs, and then File Explorer. Tap and hold the file you want to move, and tap Cut. Go to the My Documents folder in the storage card folder, tap Edit, and then tap Paste. Files stored in folders other than My Documents or stored in folders within subfolders in My Documents may not show up in the list view of some programs. When using Notes, Pocket Word, or Pocket Excel, you can also move files by opening the item and tapping Tools or Edit and then Rename/Move.

3. Move e-mail attachments. In Inbox, tap Tools and then Options. On the Storage tab, select Store attachments on storage card. All attachments are moved to the storage card, and new attachments are automatically stored on the storage card.

4. Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save new items on the storage card. In the program, tap Tools and then Options.

5. If you are copying files from your PC or another Pocket PC Phone to your Pocket PC Phone, try adjusting the slider in the Memory setting. Tap Memory and then Settings. On the System tab, tap Memory and check whether the slider can be adjusted manually before copying files.

6. Delete unnecessary files. Tap Programs, and then File Explorer. Tap and hold the file, and then tap Delete on the pop-up menu. To find your largest files, tap and then Find. In the Type list, tap Larger than 64 KB, and then tap Go.
7. In Internet Explorer options, delete all files and clear history. In Internet Explorer, tap Tools and then Options. Tap Delete Files and Clear History.

Customizing Your Pocket PC Phone
You can customize your Pocket PC Phone by adjusting Pocket PC Phone settings and installing additional software.

Customizing the Today Screen
You can customize the Today screen in the following ways: change the background picture, select the information you want displayed and in what order, and further customize to show future appointments.

To change the background

1. Tap Start, Settings, Personal and then Today.
2. On the Appearance tab, select the desired theme for the background and then tap OK. To use your own background, select Use this picture as the background and tap Browse to locate the desired file.
3. Choose a Folder and Type and then tap Find.
4. Tap the picture you want to use and then tap OK.

To customize the information you want displayed:

1. Tap Start, Settings, Personal and then Today.
2. On the Items tab:
   - Uncheck a box to remove its information.
   - Select an item and tap Move Up or Move Down to change its position.
   - Select or deselect Display Today screen if device is not used for, and then select a number of hours from the box.

To customize Tasks or Calendar:

1. Select Tasks or Calendar, Tools and then Options to further customize.
Adjusting Settings

You can adjust Pocket PC Phone settings to suit the way you work. To see available options, tap Settings, then the Personal or System tab located at the bottom of the screen.

- You might want to adjust the following:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Buttons</td>
<td>To assign application programs to hardware buttons.</td>
</tr>
<tr>
<td>📡</td>
<td>Input</td>
<td>To set up the input methods of your Pocket PC Phone.</td>
</tr>
<tr>
<td>📖</td>
<td>Menu</td>
<td>To customize what appears on the menu, and to enable a pop-up menu from the New button.</td>
</tr>
<tr>
<td>📍</td>
<td>Owner Information</td>
<td>To enter your personal contact information.</td>
</tr>
<tr>
<td>🔒</td>
<td>Password</td>
<td>To limit access to your Pocket PC Phone.</td>
</tr>
<tr>
<td>📞</td>
<td>Phone</td>
<td>To set up the phone function of your wireless feature.</td>
</tr>
<tr>
<td>🔊</td>
<td>Sounds &amp; Notification</td>
<td>To set the notification type, event and volume.</td>
</tr>
<tr>
<td>📅</td>
<td>Today</td>
<td>To customize the look and the information that is displayed on the Today screen.</td>
</tr>
<tr>
<td>🌞</td>
<td>Backlight</td>
<td>To customize the backlight brightness and automatic turnoff for power saving purposes.</td>
</tr>
<tr>
<td>⌚️</td>
<td>Clock</td>
<td>To change the time and date or to set alarms.</td>
</tr>
<tr>
<td>🔊</td>
<td>Microphone AGC</td>
<td>To enable/disable the microphone Automatic Gain Control (AGC).</td>
</tr>
<tr>
<td>🌞</td>
<td>Power</td>
<td>To maximize battery life and control external power.</td>
</tr>
<tr>
<td>🌍</td>
<td>Regional Settings</td>
<td>To customize language, number format, currency, time and date display.</td>
</tr>
<tr>
<td>🗑️</td>
<td>Remove Programs</td>
<td>To save the limited memory you may use this function to remove some application programs not used frequently.</td>
</tr>
<tr>
<td>🔍</td>
<td>Screen</td>
<td>To recalibrate screen tapping and enable/disable the Clear Type feature.</td>
</tr>
</tbody>
</table>

Changing the Default Button Settings

The hardware buttons on your Pocket PC Phone are default set for Calendar, Contacts and Phone. The phone buttons cannot be changed; however, you can change the Calendar and Contacts buttons to open other programs.
To change the default buttons

1. Tap \Settings, Personal and then Buttons.
2. Highlight a button, select a program in Button assignment, and then tap OK.

Adding or Removing Programs

Programs added to your Pocket PC Phone at the factory are stored in ROM (read-only memory). You cannot remove this software, and you will never accidentally lose ROM contents. ROM programs can be updated using special installation programs with a *xip extension. All other programs and data files added to your Pocket PC Phone after factory installations are stored in RAM (random access memory).

You can install any program created for your Pocket PC Phone as long as your Pocket PC Phone has enough memory. The most popular place to find software for your Pocket PC Phone is on the Pocket PC web site (http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync

You will need to install the appropriate Pocket PC Phone software on your PC before installing it on your Pocket PC Phone.

1. Determine your Pocket PC Phone and processor type so you know which version of the software to install.
   
   Tap \ and then Settings. On the System tab, tap About. In the Version tab, make a note of the information in Processor.
2. Download the program to your PC (or insert the CD or disk that contains the program into your PC). You may see a single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of files for different Pocket PC Phone types and processors. Be sure to select the program designed for the Pocket PC Phone and your Pocket PC Phone processor type.
3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.
4. Connect your Pocket PC Phone and PC.
5. Double click the *.exe file.
   
   • If the file is an installer, the installation wizard will begin. Follow the directions on the screen. Once the software has been installed on your PC, the installer will automatically transfer the software to your Pocket PC Phone.
   
   • If the file is not an installer, you will see an error message stating that the program is valid but it is designed for a different type of PC. You will need to move this file to your Pocket PC Phone. If you cannot find any installation instructions for the program in the Read Me file or documentation, use ActiveSync Explore to copy the program file to the Program Files folder on your Pocket PC Phone. For more information on copying files using ActiveSync, see ActiveSync Help.

Once installation is complete, tap Programs, and then the program icon to switch to it.
To add a program directly from the Internet

1. Determine your Pocket PC Phone and processor type so that you know which version of the software to install.

   - Tap and then **Settings**. On the **System** tab, tap **About**. In the **Version** tab, make a note of the information in **Processor**.

2. Download the program to your Pocket PC Phone straight from the Internet using Pocket Internet Explorer. You may see a single *.xip, *.exe or *.zip file, a Setup.exe file, or several versions of files for different Pocket PC Phone types and processors. Be sure to select the program designed for the Pocket PC Phone and your Pocket PC Phone processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.

4. Tap the file, such as a *.xip or *.exe file. The installation wizard will begin. Follow the directions on the screen.

To add a program to the Start menu

1. Tap **Settings, Menus**, the **Start Menu** tab, and then the check box for the program. If you do not see the program listed, you can either use File Explorer on the Pocket PC Phone to move the program to the Start Menu folder, or use ActiveSync on the PC to create a shortcut to the program and place the shortcut in the Start Menu folder.

2. **Using File Explorer on the Pocket PC Phone**: Tap **Settings, Programs, File Explorer**, and locate the program (tap the folder list, labeled **My Documents** by default, and then **My Pocket PC Phone** to see a list of all folders on the Pocket PC Phone). Tap and hold the program and tap **Copy** on the pop-up menu. Open the **Start Menu** folder located in the **Windows** folder, tap and hold a blank area of the window, and tap **Paste** on the pop-up menu.

3. The program will now appear on the menu. For more information on using File Explorer, see “Finding and Organizing Information” earlier in this chapter.

4. **Using ActiveSync on the PC**: Use the Explorer in ActiveSync to explore your Pocket PC Phone files and locate the program. Right click the program, and then click **Create Shortcut**. Move the shortcut to the Start Menu folder in the Windows folder. The shortcut now appears on the menu. For more information, see ActiveSync Help.

To remove programs

- Tap **Settings** and then **Settings**. On the **System** tab, tap **Remove Programs**.
- If the program does not appear in the list of installed programs, use File Explorer on your Pocket PC Phone to locate the program, tap and hold the program, and then tap **Delete** on the pop-up menu.
Chapter 4: Phone Features

About Your Phone

As well all the standard features of a mobile phone - such as mailbox and call log – there are several dialing features unique to your Pocket PC Phone. For example, you can take notes while talking, dial directly from Microsoft Contacts and easily transfer contacts between your Smart Card and the RAM of your Pocket PC Phone.

Additionally, like with a conventional mobile phone, you easily use one hand to access and navigate through the important features of your Pocket PC Phone and make calls.

Installing the Smart Card

- Remove the stylus.
- Turn over your Pocket PC Phone and open the Smart Card door with the stylus.
- Slide the Smart Card into the slot until it clicks into place. The Smart Card should be inserted exactly as the picture shows.

Removing the Smart Card

⚠ Make sure you have saved any data in open programs; opening the Smart Card door will turn your Pocket PC Phone off.
♦ Remove the stylus.
♦ Turn over your Pocket PC Phone and open the Smart Card door with the stylus.

Press the point of your stylus into the hole until the Smart Card springs out; then use your fingers to finish removing.

⚠️ Please pay particular attention to the stylus positions in the picture above related to removing the Smart Card, and the picture to the right. Do not put the stylus in the hole in the picture to the right; it will permanently damage your Pocket PC Phone.

About The Dialer Screen

To access the Dialer Screen, tap and then Phone, or press . From the dialer screen you can make calls, access Call Log, Speed Dial and Phone Settings. You can also find signal status information and important icons that tell you about your call.
The Navigation Pad and Dialing

1. **Take Call** – Press to take an incoming call.
   **Dialer Screen** – Press to activate the dialer screen.
   **Speakerphone** – Press and hold to turn on/off the speakerphone.
   **Dial** – Press to dial a number.
2. **Scroll Up** – Press to scroll up through a list.
3. **End Call** – Press to end a call.
   **Phone Signal** - Press and hold to turn on/off your phone.
4. **Call Log** – After launching the dialer screen, press to enter the Call Log feature.
5. **Scroll Down** – Press to scroll down through a list.
6. **Center** – Press to select.
7. **Speed Dial** – After launching the dialer screen, press to enter the Speed Dial feature.

The icons listed below may be seen in the top bar of the screen:

- **- Phone off or out of network service** - tap this icon to turn on the phone.
- **- In network service** - tap this icon to turn off the phone.
- **- Call Missed** - tap this icon to view the call(s) you missed.
- **- Unread E-mail or SMS** - tap the icon to view unread SMS or E-mail.
- **- Connecting in progress** - the icon will disappear when you are connected to your ISP.
- **- Shows your connection is at full strength**

**Entering Your PIN**

Most Smart Cards are preset with a PIN (Personal Identity Number), provided by your mobile service provider, which you need to enter whenever you use your Pocket PC Phone. If you are required to enter a PIN, try 1234 as your default.
1. Enter the preset PIN from your mobile phone service provider (please contact your mobile service provider).

2. Tap Enter.

   - If your PIN is entered incorrectly three times, the Smart Card will be blocked. If this happens, you can unblock it with the PIN Unblocking Key from your mobile phone service provider.

3. To change your default PIN go to Settings, tap Phone and then tap Change PIN.

Checking You Are Connected

The default settings for your Pocket PC Phone are programmed to assume you want to use your phone so, providing you have inserted a Smart Card, your Pocket PC Phone will turn on your mobile phone connection to your service provider’s network.

The icon 🔄 indicates that you are connected to the network of your mobile phone operator. Thereafter a full strength signal is indicated by 🔄, and as the strength of the signal diminishes so will the number of vertical bars in the icon, with no bars indicating no signal.

   - If you have turned the phone off, removed and then reinserted the Smart Card, your Pocket PC Phone will not automatically turn the phone on. In this event, turn it on as described below in Turning the Phone On and Off.

Turning The Phone On and Off

As indicated above your Pocket PC Phone will turn on your phone when you insert a Smart Card. However, you can choose to turn off your phone and just use the Pocket PC features at any time – and then turn the phone back on when you want.

To turn off the phone

Press and hold the 🔄 button until 🔄 appears in the navigation bar.

To turn on the phone

Press and hold 🔄 until 🔄 appears in the top toolbar.
Adjusting the Phone Volume

1. You can tap the icon or press the volume on the side bar of your Pocket PC Phone during a call.

   To adjust the conversation phone volume, you must do it during a call. If you adjust the volume at another time it will affect the ring and notification levels, and MP3.

Back Spacing and Deleting

If you tap a wrong number when you are keying in, you can back space to erase individual numbers one at a time or you can delete all the numbers in the window.

To back space over numbers

To delete the number

Tapping Clear will erase 098-57, or you can hold down the backspace key.
Basic Dialing Features

In this section you can find information on the basic features of your phone: making or answering a call, using the speakerphone, making notes during a call, putting a call on hold, and using the conferencing facility. You can also send SMS from the Dialer screen.

Making a call

With your Pocket PC Phone, you can make a call from the Dialer, Speed Dial, Call Log, Contacts and Phone Book.

To make a call from the Dialer

1. Press \( \text{Dialer} \) to bring up the dialer screen.
2. Tap the number into the keypad and then tap \( \text{Talk} \) or press \( \text{button} \).
To make a call from Contacts

You can make a call from Contacts in the following way:

1. Press the Microsoft Contacts Button, find the contact and then tap twice – once to send to the dialer screen and once to call.

   The pop-up menu and button will by default display **Call Work Tel.** However, you can customize so that the mobile number or e-mail is displayed instead:

Either:

1. Select a contact in the contact list and then press left or right on the navigation pad – the number on the screen will change.

Or:

1. In the contacts list tap the “w” in the right column next to the contact you want to customize. A pop-up menu will display the phone numbers and e-mail addresses for this contact with a dot next to the priority number.

2. In the pop-up menu select a priority. If you selected mobile number, “m” should now be in the right column next to the contact.
To make a call from Speed Dial (A)

Speed dial is a list you can create of often-dialed numbers. Information on adding a number to Speed Dial is detailed later in this chapter.

By memorizing the position of a number in the Speed Dial list, you can dial the number by entering its position number. For example:

In the picture on the left John Fredericks is at position 4. To dial his number simply tap and hold “4” on the dialer keypad. If the number holds a position of 10 or more tap the first number “1”, and then tap and hold the second number “0” to dial.

Another way to speed dial a number is to simply tap on the position number next to the entry.

To make a call from Speed Dial (B)

Alternatively, if you do not remember the position of a number in the Speed Dial list use the method below:

1. Go to Phone, press once on the left side of navigation pad, or tap Speed Dial.
2. In Speed Dial use the navigation pad to find the number you want to dial, and then press .
To make a call from the Call Log

1. Go to Phone and press the right side of the navigation pad or tap Call Log.
2. Find the call details by first selecting the category it is filed under. For example, if it is in All calls select All calls from the drop-down menu in the top-left corner.
3. Use the navigation pad to find the number and then tap the icon to the left of the number you wish to call.

   Icon ☎️ is for incoming calls; icon 📞 is for outgoing calls and icon 📞 is for missed calls.

To make a call from Phone Book

1. Tap Programs, and then tap Phone Book – wait for your Smart Card contents to load.
2. Tap and hold the name or phone number of the person you wish to call, and then select Call from the pop-up menu.
   Or
3. Tap the name or phone number of the person you wish to call, tap Tools and then tap Call.
To send SMS in phone dialer

1. Tap Tools, and then Send SMS.
2. The screen below will appear.
3. Tap New.
4. In the To field, enter either e-mail address or SMS number of one or more recipients, separating them with a semicolon, or select a name from the contact list by tapping the Address Book button. All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.
5. Compose your message. To enter preset or frequently used messages, tap My Text and select a message.
6. Tap Send when finished the message. If you are working offline, the message is moved to the Outbox folder and will be sent the next time you connect.

1. Whether you want to send or read E-mail or a SMS, you can swap by tapping Services then choose what service you want.
2. If you are sending an SMS message and want to know if it was received, tap Edit, Options, and select Request SMS text message delivery notification before sending the message.
**Enabling the Speakerphone Mode**

Your Pocket PC Phone has a speakerphone that allows you to talk hands-free and/or let other people to listen to the caller.

1. Wait until the phone is ringing.
2. Hold down the button until the speakerphone comes on and the icon appears in the top toolbar.
3. To turn off the speakerphone hold down the button again.

⚠️ Do not leave the phone in speakerphone mode and hold it to your ear; the sound may damage your ear.

---

**Answering or Rejecting a Call**

- Tap **Answer**, or press on your Pocket PC Phone.
- Tap **Ignore** or press to reject the call.

⚠️ If you reject a call the busy tone will be sent out, or the call will go to voice mail.
Ending a Call

Once an incoming or outgoing call is proceeding, you can press \( \text{end} \) or tap \( \text{end} \) to end the call.

Managing More Than One Call

Your Pocket PC Phone will notify you when you have another caller - you have the choice of rejecting or accepting the incoming call. If you accept you can then choose to swap between this caller and the original, or set up a conference call between all 3 parties. You can, of course, also initiate the situation above – with conference calling you can create a conversation between up to 6 people.

Putting a Call on Hold

1. If another person is trying to call you when you are talking on the phone, the screen to the left will pop up.
2. Tap \( \text{Answer} \) to take the 2nd call and put the 1st call on hold.
3. To end the 2nd call and go back to the 1st, tap \( \text{End} \) or \( \text{end} \).
To swap between calls

- You can choose to swap between 2 calls by pressing Swap.

To set up conference calling

1. Either put a call on hold, dial a 2nd number and wait for it to be picked up. Or, accept a 2nd incoming call when you already have one in progress.
2. In the screen that appears tap Conference.
3. If the conference connection is successful, the screen at left will appear.
4. To add additional people to your conference call tap **Hold**, key in the number, and then **Resume** to return and continue.

**Making a Note**
Regardless of whether you call from the Dialer, Contacts, Call Log, Speed Dial or Phone Book, you can take a note during a call. After you have finished the note it will be saved as an attachment to your call in one of the Call Log folders.

**To make a note**

1. After you have entered a number and tapped **or** **Talk**, tap the **icon situated at the bottom of the screen.
2. Use any of the input methods to record your note and then tap **OK**. You can finish your note during or after the call.
To view a note

1. Press the right side of the navigation pad or tap the call, and then from the pop-up menu tap View Note. (The icon indicates a note).

2. Or go to Notes, and then tap the name of the file from the list. If you decide to create a contact for this caller – see “Adding and Transferring Contact Information” – the call and file names will be amended to the name of the new contact and the file will be unaffected.

Call Related Features

Checking Your Voice Mail

- The first speed dial location defaults as your voice mailbox. When you insert your Smart Card into your Pocket PC Phone, it will automatically detect and set as default the voice mailbox number of your mobile service provider.

To retrieve your voice mail

- Press the left side of the navigation pad, select Voice Mail and then press .

Adding and Transferring Contact Information

Since there are a number of ways to enter and store telephone numbers and contacts on your Pocket PC Phone and a number of ways to make a phone call, it is important to be able transfer those contacts between the programs used to make a call.

Places where contacts can enter your Pocket PC Phone and be stored

- Your Smart Card - You interchange your Smart Card between your Pocket PC Phone and another Pocket PC Phone; while using the other Pocket PC Phone you create one or more new contacts on the Smart Card.

- Microsoft Contacts.

- Call Log – New contact numbers can be found in incoming or missed calls.
Why transfer numbers?

♦ In the event you lose your Smart Card while using it with another Pocket PC Phone, your Smart Card numbers will be backed up to your Pocket PC Phone.

♦ If you want to transfer a number to Speed Dial it must be in Contacts, not on the Smart Card.

♦ If you are using your Smart Card with another Pocket PC Phone, you may need the numbers stored in Microsoft Contacts.

♦ Transferring numbers to Microsoft Contacts allows you to create a more detailed record.

Microsoft Contacts: Adding and transferring contacts

1. To create a contact, see creating a contact in Chapter 8.

2. To transfer a contact to your Smart Card, press and hold the center of the navigation pad - or tap and hold the contact - and then select Save to SIM from the pop-up menu.

3. To transfer a contact to Speed Dial, press and hold the center of the navigation pad – or tap and hold the contact - and then select Add Speed Dial Work Tel from the pop-up menu.

4. In the next screen add the contact details, select a location and tap OK.

By default the Location function will give you the next available position in the Speed Dial list. If you want to put a number in a position that is already occupied, the new number will replace the number already there.
Phone Book: Adding and transferring contacts

To create a Smart Card contact

1. Tap Phone Book (wait for Smart Card contents to load), then New.
2. Fill in the Name and Number details and tap Save.

To transfer contacts from Smart Card to Microsoft Contacts

1. Tap Phone Book (wait for Smart Card contents to load), then
   Either:
   
   Tap Tools, then Copy All to Contacts.

   Or:
   
   Press and hold the center of the navigation pad – or tap and hold a contact from the list - and then select Copy to Contacts from the pop-up menu.
To transfer a number to Speed Dial

1. Press \[ \text{Speed Dial} \], either the left side of the navigation pad or Speed Dial, and then New.
2. Find the contact you want to add, and then press the navigation pad center.
3. When the contact name and number appears in the screen, select an available location using the arrow keys.

   By default the Location function will give you the next available position in the Speed Dial list. If you want to put a number in a position that is already occupied, the new number will replace the number already there.

To add a record to Microsoft Contacts from Call Log

1. Press \[ \text{Call Log} \] and then the right side of the navigation pad.
2. Find the call details by first selecting the category it is filed under. For example, if it is a missed call select Missed from the drop-down menu in the top-left corner.
3. Press and hold the navigation pad center; in the pop-up menu that appears select New Contact.
4. In the New Contact screen add additional contact details and press the navigation pad center or tap OK.
5. The call details in the Call Log will then be amended and displayed under the name of the contact, not the telephone number.
Managing Your Call Log

The Call Log details all incoming, outgoing, and missed calls and also provides a summary of total calls. The Call Log can also tell you when a call was initiated, how long it lasted, and provides easy access to any notes taken during the call.

Viewing details of calls

Tap in the top-left corner of the screen and then select a category from the drop-down menu.

Calls are categorized as below:

- **All Calls** - shows all calls made to and from the phone in chronological order.
- **Missed** - shows calls that were not answered.
- **Outgoing** - only shows calls made from the phone.
- **Incoming** - only shows calls made to the phone.
- **By Caller** - categorizes calls alphabetically according to caller name.

To view duration of call

- Go to Call Log, find the call you are interested in, and then tap it once.
To delete individual calls from Call Log

- Press and hold the center of the navigation pad, and then select Delete from the pop-up menu.

To delete all calls from Call Log

- Tap Tools, and then Delete all Calls.

To set limits on the size of your Call Log

- Tap Call Log, Tools, Options and then the box under Delete call log items older than.
- In the drop-down menu choose a period of time and then tap OK.

Customizing Your Phone

You can personalize the setting of your phone, the services you have and the network you are connected to.

To select ring type and tone, and keypad sounds

1. In phone dialer, tap Tools, Options and then Phone.
2. Tap to see the drop-down menu choices below.
Downloading Ring Tones
You can make a connection to the Internet and then download ring tones that are compatible with the .WAV format.

To enable the PIN
1. In phone dialer, tap Tools, Options and then Phone.
2. Under Security, tap the option Require PIN when phone is used.

To change the PIN
1. Under Security, tap Change PIN.
2. Follow the instructions - enter the old pin, then a new one, and re-enter for confirmation.

To enable Caller ID
When you place a call, your phone number will be revealed to the person that you are calling. To disable this function:
1. In phone dialer, tap Tools, Options and then Services.
2. In Services, tap Caller ID, and then Get Settings (retrieving settings may take a few minutes).
3. In the next screen, tick either **Everyone I call** (Enable) or **Never provide caller ID** (Disable) and then **OK**.

---

**Call Forwarding**

This service allows you to forward your incoming calls to another phone number. You can choose to forward all calls to the same number or specify a number based on the following conditions:

- **Unavailable**: If your phone is turned off or your phone is out of the network service.
- **Busy**: When you are on the phone.
- **No answer**: If you do not answer your phone.

**To activate or deactivate Call Forwarding**

1. In phone dialer, tap **Tools**, **Options** and then **Services**.
2. In **Services**, tap **Call Forwarding** and then **Get Settings** (retrieving settings may take a few minutes).
3. In **Call forwarding** either tick **Forward all incoming phone calls** and then enter a number in the box below – or select one or all of the other categories and enter numbers.

---

**Call Waiting**

This service allows you to receive another call during an active call. You can also turn this option off by selecting **Do not notify me**.
To activate or deactivate Call Waiting

1. In phone dialer, tap **Tools**, **Options** and then **Services**.
2. In **Services**, tap **Call waiting** and then **Get Settings** (retrieving settings may take a few minutes).
3. Then in **Call waiting** select **Notify me** or **Do not notify me** and tap **OK**.

Voice Mail and SMS

By default your Pocket PC Phone will automatically detect and set your voice mail and SMS access numbers. However, you can view the settings if you want.

To view your voice mail and SMS access numbers

1. In phone dialer, tap **Tools**, **Options** and then **Services**.
2. In **Services**, tap **Voice mail and SMS**, and then **Get Settings** (retrieving settings may take a few minutes).
3. Then in **Voice mail and SMS** type in the access numbers and tap **OK**.
To find a network

1. In phone dialer, tap Tools, Options and then Network.
2. Tap Find Network (retrieving settings may take a few minutes).

You can use this function when the network status is currently out of network service and you want to conduct a search.

To select a network

1. In phone dialer, tap Tools, Options and then Network.
2. Select either Automatic or Manual in Network selection (retrieving settings may take a few minutes when you select Manual).
To set preferred networks

1. In phone dialer, tap Tools, Options and then Network.
2. Select Set Preferred Networks (retrieving settings may take a few minutes).
3. Select any network and re-prioritize the order for network usage.

If there are many mobile phone service providers available to you, enable this function to select a lower fee network.

To select automatic pickup

This feature, which instructs your phone to pick up the call automatically, is particularly helpful when you are in a hands-free environment. For example, if you are driving and using the earphone, the call will be picked up after a designated number of rings and your hands never have to leave the wheel.

1. In phone dialer, tap Tools, Options and then More.
2. To enable, tick the box next to Answer incoming calls without pressing Talk after rings and choose the number of rings in the drop-down menu.
Using Key Lock

Key Lock enables you to lock the buttons on your Pocket PC Phone so that only the On/Off button will turn your Pocket PC Phone on. Locking your Pocket PC Phone in this way ensures you cannot switch the Pocket PC Phone on by accident, and consume unnecessary power.

Enabling Key Lock when you are using your phone features will slow down your ability to answer a call.

To enable Key Lock
1. Tap Phone, Tools, Options, and then More.
2. Under Hardware Key Lock, select Lock all buttons except Power button, and then OK.

Enabling Broadcast Channels

You can choose to receive real-time news and information, such as traffic news and weather reports.

To enable Broadcast Channels
1. Tap Phone, Tools, Options, and then More.
2. Under Broadcast Channels tick Enable, and then tap OK.
Additional Dialing Information

To make an emergency call

Enter the emergency number 911 then Talk or press the button.

1. Your Pocket PC Phone also provides international emergency number 112. This number can normally be used to make an emergency call in any country - with/without a Smart Card inserted, as long as you are in a mobile phone service network.

2. Some mobile phone service providers may require that a Smart Card be inserted, and in some cases that the PIN has been entered as well.

3. In some cases, other emergency numbers may also be available. Your mobile phone service provider may save additional local emergency numbers in the Smart Card.

To make an international call

1. Tap and hold the 0 key until the + sign appears. The + replaces the international prefix of the country from where you are calling.

2. Enter the full phone number you want to dial. It includes country code, area code (without the leading zero) and phone number.

3. Tap Talk or press the button.
Chapter 5: Getting Connected

You can use your Pocket PC Phone to exchange information with other mobile Pocket PC Phones as well as your PC, a network, or the Internet. You have the following connection options:

- Use the infrared (IR) port on your Pocket PC Phone to send and receive files between two Pocket PC Phones.
- Connect to your mobile Internet service provider (ISP). Once connected, you can send and receive e-mail messages by using Inbox and view Web or WAP pages by using Microsoft Pocket Internet Explorer. The communication software for creating a wireless ISP connection is already installed on your Pocket PC Phone. Your service provider will provide software needed to install other services, such as paging and fax services.
- Connect to the network at your company or organization where you work. Once connected, you can send and receive e-mail messages by using Inbox, view Web or WAP pages by using Pocket Internet Explorer, and synchronize with your PC.
- Connect to the virtual private network (VPN) at the company or organization where you work. Many corporations have a need to extend their secure corporate Intranet to remote users. In the past, Remote Access Servers (RAS) have been used. The remote user would need to use a dial-up connection to the corporate RAS server. This was considered secure since the phone lines were directly connected from the remote user to the RAS server, which is part of the corporate Intranet. But with the advent of ready access to the Internet for many remote users, using the Internet to access the corporate Intranet was easier and much less expensive.

The dilemma was how to keep corporate data secure while using the very public Internet. The answer was to implement a VPN solution. The textbook definition of a VPN is as follows: a combination of tunneling, encryption, authentication, and access control technologies and services used to carry traffic over the Internet, a managed IP network or a provider’s backbone. The VPN solution requires software on the remote user’s computer as well as a VPN server within the corporate Intranet.

A tunneling protocol is a method to encrypt the data over the Internet. The encryption key is known to the remote user and the server, so anyone trying to access the data along the Internet path would not be able to decrypt the data. There are currently three tunneling protocols that are used in the majority of VPNs: IP Security (IPSec), the Layer 2 Tunneling Protocol (L2TP) and the Point-to-Point Tunneling Protocol (PPTP). Of the three PPTP is the most widely used. Microsoft supports PPTP within Windows and the Pocket PC Phone.

The T-Mobile network supports the use of these three protocols with our VPN-ready wireless data service. Our VPN-ready wireless data rate plans will provide you with a dedicated public Internet protocol address (known as an Internet 3 address or I3). Be sure to advise your sales representative that you will need a VPN-ready wireless data rate plan.

If you plan to use your Pocket PC Phone to access the Internet only, then our standard Internet-ready wireless data rate plans will be adequate. Be sure to check with your company’s IT department as to the requirements for your corporate VPN solution.

Once connected, the added security of a VPN means that you can access the full resources of your company’s network. For example, you can use File Explorer to access the files of computers on that network.

Getting Help on Connecting

More information on creating a connection to work or the Internet, as well as information on additional procedures, can be found in the following locations:

- The accompanying Welcome Guide.
- Online Help on the Pocket PC Phone. Tap and then Help. Tap View, All Installed Help, and then Inbox or Connections.
- ActiveSync Help on the desktop PC. In ActiveSync, click Microsoft ActiveSync Help on the Help menu.

For troubleshooting information, see the Pocket PC Web site at: http://www.microsoft.com/mobile/pocketpc
Chapter 6: Wireless Data Programs

As well as wireless voice communication your Pocket PC Phone has built-in support for a range of wireless data communication forms. You can:

1. Browse the Web and view WAP-enabled sites.
2. Send SMS text messages.
3. Send and receive e-mail.
4. Synchronize with your desktop PC remotely.
5. Send and receive information from another IR-compatible Windows-powered Pocket PC Phone.

Except in the case of No. 5 above, in order to use these features the following steps must have been completed:

1. Your mobile phone service provider supports data transmission. (For further information contact your mobile phone service provider).
2. You have an account for Web and e-mail access with an ISP or at a network through your company or another organization. (It may be that your mobile phone service provider is acting as your ISP)
3. You have set up a dial-up connection to an ISP or network on your Pocket PC Phone.
4. Your wireless connection to your mobile service provider is turned on but you are not using it.
5. You have switched on one of the dial-up networking connections established in No. 4 above.

Pocket Internet Explorer: Browsing Web and WAP pages

Use Microsoft® Pocket Internet Explorer to view Web HTML, cHTML and WAP pages. You can browse in either of these ways:

- During synchronization with your PC, download your favorite links and mobile favorites that are stored in the Mobile Favorites folder in Internet Explorer on the PC.
- Connect to an Internet service provider (ISP) or network and browse the Web. To do this, you will need to create the connection first, as described in the separate Welcome Guide.

When connected to an ISP or network, you can also download files and programs from the Internet or Intranet.
Using Pocket Internet Explorer

To switch to Pocket Internet Explorer:
  - Tap \(\text{Internet Explorer}\) and then Internet Explorer.

You can use Pocket Internet Explorer to browse mobile favorites and channels that have been downloaded to your Pocket PC Phone without connecting to the Internet. You can also connect to the Internet through an ISP or a network connection and browse Web/WAP pages.

To view Mobile Favorites and Channels

1. Tap the Favorites button to display your list of favorites.
2. Tap the page you want to view.
3. You will see the page that was downloaded the last time you synchronized with your desktop PC. If the page is not on your Pocket PC Phone, the favorite will be dimmed. You will need to synchronize with your desktop PC again to download the page to your Pocket PC Phone, or connect to the Internet to view the page.

To browse the Internet

1. Set up a connection to your ISP or corporate network using Connections, as described in the separate Welcome Guide.
2. To connect and start browsing, do one of the following:
   - Tap the Favorites button, and then tap the favorite you want to view.
   - Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter the Web address you want to visit and then tap Go. Tap the arrow to choose from previously entered addresses.

To add a favorite link while using the Pocket PC Phone, go to the page you want to add, tap and hold on the page and tap Add to Favorites.
The Mobile Favorites Folder

Only items stored in the Mobile Favorites folder in the Favorites folder in Internet Explorer on your desktop PC will be synchronized with your Pocket PC Phone. This folder was created automatically when you installed ActiveSync.

Favorite Links

During synchronization, the list of favorite links in the Mobile Favorites folder on your desktop PC is synchronized with Pocket Internet Explorer on your Pocket PC Phone. Both your PC and your Pocket PC Phone are updated with changes made to either list each time you synchronize. Unless you mark the favorite link as a mobile favorite, only the link will be downloaded to your Pocket PC Phone, and you will need to connect to your ISP or network to view the content. For more information on synchronization, see ActiveSync Help on the desktop PC.

Mobile Favorites

If you are using Microsoft Internet Explorer 5.0 or later on your desktop PC, you can download mobile favorites to your Pocket PC Phone. Synchronizing mobile favorites downloads Web content to your Pocket PC Phone so that you can view pages while you are disconnected from your ISP and desktop PC.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites quickly.

To create a Mobile Favorite

1. In Internet Explorer on your desktop PC, click Tools and then Create Mobile Favorite.
2. To change the link name, enter a new name in the Name box.
3. Optionally, in Update, select a desired update schedule.
4. Click OK. Internet Explorer downloads the latest version of the page to your desktop PC.
5. Limit the number of downloaded linked pages. In Internet Explorer on the desktop PC, click Favorites. Then move your mouse through Mobile Favorites to the mobile favorite you want to change. Finally, right-click the mobile favorite and then Properties. In the Download tab, specify 0 or 1 for the number of linked pages you want to download.
6. Synchronize your Pocket PC Phone and desktop PC. Mobile favorites that are stored in the Mobile Favorites folder in Internet Explorer are downloaded to your Pocket PC Phone.

   If you did not specify an update schedule in step 3, you will need to manually download content to keep the information updated on your desktop PC and Pocket PC Phone. Before synchronizing with your Pocket PC Phone, in Internet Explorer on your desktop PC, click Tools and then Synchronize. You will see the last time content was downloaded to the desktop PC, and you can manually download content if needed.

   You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet Explorer on your desktop PC, click View, Toolbars and then Customize.

Saving Pocket PC Phone Memory

Mobile favorites take up storage memory on your Pocket PC Phone. To minimize the amount of memory used:

- In ActiveSync on your desktop PC, click Options, select Favorites/Internet Explorer, tap Settings and then Customize. You can then deselect Synchronize Images, Synchronize Sound and/or Synchronize offline content pages, to stop pictures and sounds, or some mobile favorites from being downloaded to the Pocket PC Phone. For more information, see ActiveSync Help.

- Limit the number of downloaded linked pages. In Internet Explorer on the desktop PC, click Favorites, then move your mouse through Mobile Favorites to the mobile favorite you want to change. Finally, right-click the mobile favorite and then Properties. In the Download tab, specify 0 or 1 for the number of linked pages you want to download.
To browse the Internet
1. Set up a connection to your ISP or corporate network using Connections, as described in the separate Welcome Guide.
2. To connect and start browsing, do one of the following:
   - Tap the Favorites button, and then tap the favorite you want to view.
   - Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter the Web address you want to visit and then tap Go. Tap the arrow to choose from previously entered addresses.
   - To add a favorite link while using the Pocket PC Phone, go to the page you want to add, tap and hold on the page and tap Add to Favorites.

Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites. You subscribe to AvantGo channels directly from your Pocket PC Phone. Then, you synchronize your Pocket PC Phone and desktop PC, or connect to the Internet to download the content. For more information, visit the AvantGo Web site.

To sign up for AvantGo
1. In ActiveSync options on the desktop PC, turn on synchronization for the AvantGo information type.
2. In Pocket Internet Explorer on your Pocket PC Phone, tap the Favorites button to display your list of favorites.
3. Tap the AvantGo Channels link.
4. Follow the directions on the screen. You will need to synchronize your Pocket PC Phone with your desktop PC and then tap the My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a few of the most popular channels. To add or remove channels, tap the Add or Remove link.

MSN Messenger: Instant Messaging
MSN Messenger on your Pocket PC Phone is an instant messaging program that lets you:
   - See who is online.
   - Send and receive instant messages.
   - Have instant message conversations with groups of contacts.

To use MSN Messenger, you must have a Microsoft Passport™ account or a Microsoft Exchange e-mail account. You must have a Passport to use MSN Messenger Service. If you have a Hotmail® or MSN account, you already have a Passport. Once you have obtained either a Microsoft Passport or a Microsoft Exchange account, you are ready to set up your account.


To switch to MSN Messenger
Tap Programs, and then tap MSN Messenger.
Setting Up An Account
Before you can connect, you must enter Passport or Exchange account information.

To set up an account and sign in:
1. In the Tools menu, tap Options.
2. In the Accounts tab, enter your Passport or Exchange account information.
3. To sign in, tap the sign-in screen and enter your e-mail address and password.

To change from your Exchange account to your Passport account and sign in:
1. In the Tools menu, tap Options.
2. In the Accounts tab, tick Enable Passport account and enter your Passport account information. Under Sign in using this account first, tick Passport account, and then tap OK.
3. To sign in, tap the sign-in screen and enter your e-mail address and password.

If you already use MSN Messenger on your desktop PC, your contacts will show up on your Pocket PC Phone without being added again.

Working with Contacts

- The MSN Messenger window shows all of your messenger contacts at a glance, divided into Online and Not Online categories. While connected, you can chat, send e-mail, block the contact from chatting with you, or delete contacts from your list using the pop-up menu.

To see others online without being seen, in the Tools menu, tap My Status and select Appear Offline. If you block a contact, you will appear offline but will remain on the blocked contact’s list. To unblock a contact, tap and hold the contact, then tap Unblock on the pop-up menu.
Chatting with Contacts

- Tap a contact name to open a chat window. Enter your message in the text entry area at the bottom of the screen, or tap My Text to enter a preset message, and tap Send. To invite another contact to a multi-user chat, in the Tools menu, tap Invite and tap the contact you want to invite.

To switch back to the main window without closing a chat, tap the Contacts button. To revert back to your chat window, tap Chats and select the person whom you were chatting with.

Inbox: Sending and Receiving E-mail or SMS

Use Inbox to send and receive e-mail messages in either of these ways:

- Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop PC.
- Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a network.

You also can use Inbox to send and receive SMS text messages. Inbox supports 8 bits data with class 0, 1, 2, 3 plus Unstructured Supplementary Service Data (USSD).
Synchronizing E-mail Messages

E-mail messages can be synchronized as part of the general synchronization process. You will need to enable Inbox synchronization in ActiveSync. For information on enabling Inbox synchronization, see ActiveSync Help on the desktop PC.

During synchronization:

- Messages are copied from the mail folders of Exchange or Outlook on your desktop PC to the ActiveSync folder in Inbox on your Pocket PC Phone. By default you will receive messages from the past five days only, and only the first 100 lines of each message.
- E-mail messages in the Outbox folder on your Pocket PC Phone are transferred to Exchange or Outlook, and then sent from those programs.
- E-mail messages in folders must be selected in ActiveSync on your desktop PC in order to be transferred.

Connecting Directly to an E-mail Server

In addition to synchronizing e-mail messages with your desktop PC, you can send and receive e-mail messages by connecting to an e-mail server using a modem or network card connected to your Pocket PC Phone. You will need to set up a remote connection to a network or an ISP, and a connection to your e-mail server.

When you connect to the e-mail server, new messages are downloaded to the Pocket PC Phone Inbox folder, messages in the Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from the Inbox folder. Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your PC. When you delete a message on your Pocket PC Phone, it is also deleted from the e-mail server the next time you connect - based on the settings you selected in ActiveSync.

You can work online or offline. When working online, you read and respond to messages while connected to the e-mail server. Messages are sent as soon as you tap Send, which saves space on your Pocket PC Phone.

When working offline, once you have downloaded new message headers or partial messages, you can disconnect from the e-mail server and then decide which messages to download completely. The next time you connect, Inbox downloads the complete messages you have marked for retrieval and sends the messages you have composed.

Using the Message List

Messages you receive are displayed in the message list. By default, the most recently received messages are displayed in the list first.
When you receive a message, tap it to open it. Unread messages are displayed in bold.

When you connect to your e-mail server or synchronize with your desktop PC, by default, you will receive messages from the last five days only and only the first 100 lines of each new message. The original messages remain on the e-mail server or your desktop PC.

You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection. In the message list, tap and hold the message you want to retrieve. On the pop-up menu, tap Mark for Download. The icons in the Inbox message list give you visual indication of message status.

You specify your downloading preferences when you set up the service or select your synchronization options. You can change them at any time:

- Change options for Inbox synchronization using ActiveSync options. For more information, see ActiveSync Help.
- Change options for direct e-mail server connections in Inbox on your Pocket PC Phone. Tap Tools and then tap Options. On the Service tab, tap the service you want to change. Tap and hold the service and select Delete to remove a service.
Creating an SMS text message or E-mail

1. Tap New.
2. In the To field, enter either e-mail address or SMS number of one or more recipients, separating them with a semicolon, or select a name from the contact list by tapping the Address Book button. All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.
3. Compose your message. To enter preset or frequently used messages, tap My Text and select a message.
4. Tap Send when you have finished the message. If you are working offline, the message is moved to the Outbox folder and will be sent the next time you connect.

1. Whether you want to send or read E-mail or a SMS, you can swap by tapping Services then choosing what service you want.
2. If you are sending an SMS message and want to know if it was received, tap Edit, Options, and select Request SMS text message delivery notification before sending the message.

Managing Messages and Folders

By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted Items, Drafts, Outbox and Sent Items. The Deleted Items folder contains messages that have been deleted on the Pocket PC Phone. The behavior of the Deleted and Sent Items folders depends on the options you have chosen. In the message list, tap Tools and then Options. On the Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, and then Manage Folders to create new folders. To move a message to another folder, in the message list, tap and hold the message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an e-mail server

The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4.

1. If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your Pocket PC Phone. You can select to synchronize additional folders by designating them for ActiveSync. The folders you created and the messages you moved will then be mirrored on the server. For example, if you move two messages from the Inbox folder to a folder named ‘Family’, and you have designated ‘Family’ for synchronization, the server creates a copy of the ‘Family’ folder and copies the messages into that folder. You can then read the messages while away from your PC.
2. If you use SMS, messages are stored in the Inbox folder of SMS category.
3. If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the Pocket PC Phone and their copies on the mail server. The next time you connect, the mail server will see that the messages are missing from the Pocket PC Phone Inbox and delete them from the server. This prevents you from having duplicate copies of a message, but it also means that you will no longer have access to messages that you move to folders created from anywhere except the Pocket PC Phone.
4. If you use IMAP4, the folders you created and the e-mail messages you moved are mirrored on the server. Therefore,
messages are available to you anytime you connect to your mail server, whether it is from your Pocket PC Phone or PC. This synchronization of folders occurs whenever you connect to your mail server; create new folders, or rename/delete folders when connected.

Transferring Items Using Infrared
Using infrared (IR), you can send and receive information, such as contacts and appointments, between two Pocket PC Phones.

To send information
1. Switch to the program where you created the item you want to send and locate the item in the list.
2. Align the IR ports so that they are unobstructed and within close range.
3. Tap and hold the item, and tap Beam Item on the pop-up menu.
   - You can also send items, but not folders, from File Explorer. Tap and hold the item you want to send, and then tap Beam File on the pop-up menu.

To receive information
1. Align the IR ports so that they are unobstructed and within close range.
2. Have the owner of the other Pocket PC Phone send the information to you. Your Pocket PC Phone will automatically receive it.

Terminal Services Client
Using the Terminal Services Client, you can log onto a Windows NT server-type PC that is running Terminal Services software and use all of the programs that are available on that PC from your Pocket PC Phone. For example, instead of running Microsoft Pocket Word, you can run the PC version of Microsoft Word and access all of the .doc files on that PC from your Pocket PC Phone.

- You cannot use Transcriber when entering information in Terminal Services. You must use Keyboard, Block Recognizer, or Letter Recognizer.

To connect to a Terminal Server
Start a remote connection to the server via your wireless modem connection.

1. Tap Programs, and then Terminal Services Client.
2. To connect to a server you have previously connected to, in Recent Servers, tap a server.
3. To connect to a new server, enter the server’s name in the Server box. Select the limit size of desktop PC to fit on the screen check box only when using applications that have been specifically sized for use with your Pocket PC Phone.
4. Tap Connect.
   - If the network administrator has configured Terminal Services Client to reconnect to disconnected sessions, and you previously disconnected from a Terminal Server without ending the session, the Terminal Services Client reconnects to that session.
To disconnect without ending a session

The following commands must be accessed from the Start menu in the Terminal Services window used to access the PC’s commands. Do not use the Start menu on your Pocket PC Phone.

1. In the Terminal Services Client window, tap and then Shutdown.
2. Tap Disconnect.

If the network administrator has configured Terminal Services Client to reconnect to disconnected sessions, you will be reconnected to this session the next time you connect to this server.

To disconnect and end a session

1. In the Terminal Services Client window, tap and then Shutdown.
2. Tap Log Off.

To navigate within Terminal Services Client

Once connected to the server, the PC’s screen may more than fill your Pocket PC Phone’s screen. If scroll bars are displayed on the server’s screen, you will see more than one set of scroll bars on your Pocket PC Phone:

- One to scroll information on the PC, and one to scroll the PC display through the Terminal Services window in Terminal Services Client.
- To ensure you are scrolling the PC display through Terminal Services Client, use the four directional buttons at the bottom of the Terminal Services Client screen.
- To better fit information on your Pocket PC Phone’s screen, select Limit size of server desktop PC to fit on this screen. For best effect, programs on the PC should be maximized.

To improve display performance

Display performance is improved by decreasing the time it takes for the screen to be refreshed on the PC.

1. On your PC select Settings and Control Panel.
2. Double click Display.
3. Clear the Use transition effects for menus and tool tips check box under the Effects tab.

To improve browser performance

Performance with Internet Explorer on the PC is improved by decreasing the time it takes for Web pages to be refreshed.

In Internet Explorer on your PC, select Tools, Internet Options, Advanced, and then clear the Use smooth scrolling check box.
Chapter 7 : Microsoft ActiveSync

Using Microsoft ActiveSync, you can synchronize the information on your desktop PC with the information on your Pocket PC Phone. Synchronization compares the data on your Pocket PC Phone with your desktop PC and updates both with the most recent information. For example:

- Keep Pocket Outlook data up-to-date by synchronizing your Pocket PC Phone with Microsoft Outlook data on your PC.
- Synchronize Microsoft Word and Microsoft Excel files between your Pocket PC Phone and PC. Your files are automatically converted to the correct format.

By default, ActiveSync does not automatically synchronize all types of information. Use ActiveSync options to turn synchronization on and off for specific information types.

With ActiveSync you can also:

- Back up and restore your Pocket PC Phone data.
- Copy (rather than synchronize) files between your Pocket PC Phone and PC.
- Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually while connected to your PC or only when you choose the synchronize command.
- Select which information types are synchronized and control how much data is synchronized. For example, you can choose how many weeks of past appointments you want synchronized.

After installation is complete, the ActiveSync Setup Wizard helps you connect your Pocket PC Phone to your PC, set up a partnership so you can synchronize information between your Pocket PC Phone and your PC, and customize your synchronization settings. Your first synchronization process will automatically begin when you finish using the wizard.

After your first synchronization, take a look at Calendar, Contacts, and Tasks on your Pocket PC Phone. You will notice that information you have stored in Microsoft Outlook on your PC has been copied to your Pocket PC Phone, and you did not have to type a word. Disconnect your Pocket PC Phone from your PC and you are ready to go!

Once you have set up ActiveSync and completed the first synchronization process, you can initiate synchronization from your Pocket PC Phone. To switch to ActiveSync on your Pocket PC Phone, tap and then tap ActiveSync. Note that if you have a wireless LAN card, you can synchronize remotely from your Pocket PC Phone.

For information about using ActiveSync on your PC, start ActiveSync on your PC and then see ActiveSync Help.
Synchronizing Files

When you first set up a connection, or by tapping **Options** in **ActiveSync** on your desktop PC, under **Mobile Pocket PC Phone** you can see the list of programs you can synchronize. This list includes: **Calendar, Contacts, Tasks, Inbox, Files, Pocket Access, Favorites** and **AvantGo** channels. **Files** is a folder specially-created on your desktop PC in **My Documents** into which you must place all files (Word, Excel etc.) you wish to synchronize.

To synchronize files

1. Select **Files** in **ActiveSync**, and then **OK** to create a new folder.

2. Use **Windows Explorer** on your desktop PC to find this folder – usually called “My Documents” pre-fixed by the name you gave to your connection – then copy files you want to synchronize into this folder.

3. Tap **Synchronize** in **ActiveSync**.

For more information about ActiveSync on your Pocket PC Phone, switch to **ActiveSync**, tap and then tap **Help**.
Chapter 8: Microsoft Pocket Outlook

Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox and Notes. You can use these programs individually or together. For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox.

Using ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your PC with your Pocket PC Phone. You can also synchronize this information directly with a Microsoft Exchange server. Each time you synchronize, ActiveSync compares the changes you made on your Pocket PC Phone and PC or server, and updates both with the latest information. For information on using ActiveSync, see ActiveSync Help on the PC.

You can switch to any of these programs by tapping them on the menu.

Calendar: Scheduling Appointments and Meetings

- Use Calendar to schedule appointments, including meetings and other events. You can check your appointments in one of several views (Agenda, Day, Week, Month, and Year) and easily switch views by using the View menu.

You can customize the Calendar display, such as changing the first day of the week, by tapping Options on the Tools menu.
To create an appointment

1. If you are in Day or Week view, tap the desired date and time for the appointment.
2. Tap New.
3. Using the input panel, enter a description and a location. Tap first to select the field.
4. If needed, tap the date and time to change them.
5. Enter other desired information. You will need to hide the input panel to see all available fields.
6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, see Notes: Capturing Thoughts and Ideas later in this chapter.
7. When finished, tap OK to return to the calendar.

If you select Remind me in an appointment, your Pocket PC Phone will remind you according to the options set in Settings, Personal tab, Sounds & Reminders.

Using the Summary Screen

• When you tap an appointment in Calendar, a summary screen is displayed. To change the appointment, tap Edit.

Creating Meeting Requests

You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request will be created automatically and sent either when you synchronize Inbox or when you connect to your e-mail server. Indicate how you want meeting requests sent by tapping Tools and then Options. If you send and receive e-mail messages through ActiveSync, select ActiveSync.
To schedule a meeting

1. Create an appointment.
2. In the appointment details, hide the input panel, and then tap Attendees.
3. From the list of e-mail addresses you have entered in Contacts, select the meeting attendees.
4. The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help and Inbox Help on your Pocket PC Phone.

Contacts: Tracking Friends and Colleagues

- Contacts maintains a list of your friends and colleagues so that you can easily find the information you are looking for, whether you are at home or on the road. Using the Pocket PC Phone infrared (IR) port, you can quickly share Contacts information with other Pocket PC Phone users.

To change the way information is displayed in the list, tap Tools and then Options.
To create a contact

1. Tap New.
2. Using the input panel, enter a name and other contact information. You will need to scroll down to see all available fields.
3. To assign the contact to a category, scroll to and tap Categories and select a category from the list. In the contact list, you can display contacts by category.
4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, see Notes: Capturing Thoughts and Ideas later in this chapter.
5. When finished, tap OK to return to the contact list.

To find a contact

There are 6 ways to find a contact:

1. Press and hold the upside of the navigation pad until alphabetical letters appear on the screen in large type. Then use the navigation pad to scroll through the alphabet and select a letter.
2. Tap one of the grouping of letters displayed across the top of the screen.
3. In the contact list, enter a contact name in the box under the navigation bar. To show all contacts again, clear text from the box or tap the button to the right of the box.
4. In the contact list, tap the category list (labeled All Contacts by default) and select the type of contact that you want displayed. To show all contacts again, select All Contacts. To view a contact not assigned to a category, select None.
5. To view the names of companies your contacts work for, in the contact list, tap View > By Company. The number of contacts that work for that company will be displayed to the right of the company name.
6. Tap Find, enter the contact name, select Contacts for the type and then tap Go.
Using the Summary Screen

- When you tap a contact in the contact list, a summary screen is displayed. To change the contact information, tap **Edit**.

Tasks: Keeping a To Do List

- Use Tasks to keep track of what you have to do.

To change the way information is displayed in the list, tap **Tools** and then **Options**.
To create a task

1. Tap New.

2. Using the input panel, enter a description.

3. You can enter a start date and due date or enter other information by first tapping the field. If the input panel is open, you will need to hide it to see all available fields.

4. To assign the task to a category, tap Categories and select a category from the list. In the task list, you can display tasks by category.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, see Notes: Capturing Thoughts and Ideas later in this chapter.

6. When finished, tap OK to return to the task list.

To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap Tap here to add a new task and enter your task information.

Using the Summary Screen

- When you tap a task in the task list, a summary screen is displayed. To change the task, tap Edit.
Notes: Capturing Thoughts and Ideas

- Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can create a written note or a recording. You can also include a recording in a note. If a note is open when you create the recording, it will be included in the note as an icon. If the note list is displayed, it will be created as a stand-alone recording.

To create a note

1. Tap New.
2. Create your note by writing, drawing, typing and recording. For more information about using the input panel, writing and drawing on the screen, and creating recordings, see Chapter 3.
Chapter 9: Companion Programs

The companion programs consist of Microsoft Pocket Word, Microsoft Pocket Excel, Microsoft Money, Windows Media Player for the Pocket PC Phone and Microsoft Reader.

To switch to a companion program on your Pocket PC Phone, tap Programs on the menu, and then tap the program name.

Pocket Word

Pocket Word works with Microsoft Word on your desktop PC to give you easy access to copies of your documents. You can create new documents on your Pocket PC Phone, or you can copy documents from your PC to your Pocket PC Phone. Synchronize documents between your PC and your Pocket PC Phone so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents such as letters, meeting minutes and trip reports. To create a new file, tap Programs, Pocket Word, and then New. A blank document appears. Or, if you have selected a template for new documents in the Options dialog box under Tools, that template appears with appropriate text and formatting already provided. You can open only one document at a time; when you open a second document, you will be asked to save the first. You can save a document you create or edit in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).

Pocket Word contains a list of the files stored on your Pocket PC Phone. Tap a file in the list to open it. To delete, make copies of, and send files, tap and hold a file in the list. Then select the appropriate action on the pop-up menu.

You can change the zoom magnification by tapping View and then Zoom. Then select the percentage you want. Select a higher percentage to enter text and a lower one to see more of your document.

If you are opening a Word document created on a PC, select Wrap to Window on the View menu so that you can see the entire document.

You can enter information in Pocket Word in one of four modes (writing, drawing, typing and recording) which are displayed on the View menu. Each mode has its own toolbar that you can show and hide by tapping the Show/Hide Toolbar button on the command bar.
Typing Mode

- Using the input panel, enter typed text into the document. For more information on entering typed text, see Chapter 3.
- To format existing text and to edit text, first select the text. You can select text as you do in an MS-Word document, using your stylus instead of the mouse to drag through the text you want to select. You can search a document to find text by tapping Edit and then Find/Replace.

Writing Mode

- In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a guide, and the zoom magnification is greater than in typing mode to allow you to write more easily. For more information on writing and selecting writing, see Chapter 3.

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can be edited and manipulated as described in the following section. Written words are converted to graphics (metafiles) when a Pocket Word document is converted to a Word document on your PC.
Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift your stylus off the screen after the first stroke, you will see a drawing box indicating the boundaries of the drawing. Every subsequent stroke within or touching the drawing box becomes part of the drawing. For more information on drawing and selecting drawings, see Chapter 3.

Recording Mode

In recording mode, embed a recording into your document. Recordings are saved as .wav files. For more information on recording, see “Recording a Message” in Chapter 3.

For more information on using Pocket Word, tap and then Help.

Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop PC to give you easy access to copies of your workbooks. You can create new workbooks on your Pocket PC Phone, or you can copy workbooks from your PC to your Pocket PC Phone. Synchronize workbooks between your PC and your Pocket PC Phone so that you have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs. To create a new file, tap Programs, Pocket Excel and then New. A blank workbook appears. Or, if you have selected a template for new workbooks in the Options dialog box under Tools, that template appears with appropriate text and formatting already provided. You can open only one workbook at a time; when you open a second workbook, you will be asked to save the first. You can save a workbook you create or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).
Pocket Excel contains a list of the files stored on your Pocket PC Phone. Tap a file in the list to open it. To delete, make copies of, and send files, tap and hold a file in the list. Then select the appropriate action from the pop-up menu. Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting and filtering. To display the toolbar, tap View and then Toolbar.

If your workbook contains sensitive information, you can protect it with a password. To do so, open the workbook, tap Edit and then Password. Every time you open the workbook, you will need to enter the password, so choose one that is easy for you to remember but hard for others to guess.

Tips for Working in Pocket Excel

Note the following when working with large worksheets in Pocket Excel:

- View in full screen mode to see as much of your worksheet as possible. Tap View and then Full Screen. To exit full screen mode, tap Restore.
- Show and hide window elements. Tap View and then tap the elements you want to show or hide.
- Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View and then Freeze Panes. You might want to freeze the top and leftmost panes in a worksheet to keep row and column labels visible as you scroll through a sheet.
- Split panes to view different areas of a large worksheet. Tap View and then Split. Then drag the split bar to where you want it. To remove the split, tap View and then Remove Split.
- Show and hide rows and columns. To hide a row or column, select a cell in the row or column you want to hide. Then tap Format, Row or Column, and then Hide. To show a hidden row or column, tap Tools, Go To and then type a reference that is in the hidden row or column. Tap Format, Row or Column and Unhide.

Windows Media Player for Pocket PC Phone

Use Microsoft Windows Media Player for Pocket PC Phone to play digital audio and video files that are stored on your Pocket PC Phone or on a network. To switch to Windows Media Player for Pocket PC Phone, tap Programs, and then tap Windows Media.
Use Microsoft Windows Media Player on your PC to copy digital audio and video files to your Pocket PC Phone. You can play Windows Media and MP3 files on your Pocket PC Phone.

For more information about using Windows Media Player for Pocket PC Phone, tap and then tap Help.

Microsoft Reader

Use Microsoft Reader to read e-Books on your Pocket PC Phone. Download books to your PC from your favorite e-Book Web site. Then use ActiveSync to copy the book files to your activated Pocket PC Phone. The books appear in the MS-Reader Library, where you can tap them in the list to open them.

Each book consists of a cover page, an optional table of contents and the pages of the book. You can:

- Page through the book by using the Up/Down control on your Pocket PC Phone or by tapping the page number on each page.
- Annotate the book with highlighting, bookmarks, notes and drawings.
- Search for text and look up definitions for words.
- The guidebook contains all the information you will need to use the software. To open the guidebook, tap Help on the Reader command bar. Or, on a book page, tap and hold on the book title and then tap Help on the pop-up menu.
- To switch to Microsoft Reader, tap Programs and then Microsoft Reader.
Getting Books on Your Pocket PC Phone

You can purchase and download book files from the Web to your desktop PC and then synchronize them with your Pocket PC Phone. However, you must have activated your Pocket PC Phone (you only need to activate it once); have an activated copy of Microsoft Reader on your PC, and have set up synchronization for Files in ActiveSync.

1. Open ActiveSync on your desktop PC and check you have selected synchronize Files. If you have done so it will appear under Information Type. If you have not click Options, Sync options, tick Files and then OK from the pop-up menu. The pop-up menu is telling you your computer will create a folder in which you must put files you wish to synchronize.

2. If you have not already activated your Pocket PC Phone, open a web browser, go to http://das.Microsoft.com/activate and follow the instructions.


4. If you do not have a copy of Microsoft Reader on your PC, go to one of the retailers listed above and download a free copy from their site. Then activate it as described above.

5. Go to one of the Microsoft Reader e-Book sites and follow the instructions in the site for choosing, purchasing and downloading a book to your desktop PC.

6. Use Windows Explorer on your desktop PC to locate the Microsoft Reader “My Library” folder and the “Pocket_PC My Documents” folder, find the book title in My Library and then copy it to Pocket_PC My Documents. ActiveSync will then download the files from your PC to your activated Pocket PC Phone.

Sample books and a dictionary are also included in the Microsoft Reader folder in the Extras folder on the Pocket PC Companion CD.

Using the Library

The Library is your Reader home page; it displays a list of all books stored on your Pocket PC Phone or storage card.

To open the Library:
- On the Reader command bar, tap Library.
- On a book page, tap the book title and then tap Library on the pop-up menu.

To open a book:
- Tap its title in the Library list.
**Reading a Book**

Each book consists of a cover page, an optional table of contents and the pages of the book. Navigation options are listed in the bottom portion of the cover page.

The first time you open a book, you will probably want to go to the first page or to the table of contents, if there is one.

Subsequently, whenever you open the book, you will be automatically taken to the last page read.

In addition to the text, each book page includes a page number and book title.

You can also page through a book by using the Up/Down control on your Pocket PC Phone.

---

**Using Reader Features**

Reading a book electronically gives you several options not available with paper books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the pop-up menu as described here:

- **Search for Text.** Find text in a book by tapping **Find** on the pop-up menu. Enter the word you want to search for, and tap the desired **Find** option. Reader highlights found text on the page. To close **Find**, tap outside the box. To return to your original page, tap the title and then tap **Return** on the pop-up menu.

- **Copy Text.** You can copy text from books that support this feature into any program that accepts text. On a book page, select the text you want to copy. Then tap **Copy Text** on the pop-up menu. The text can be pasted into the program of your choice.

- **Bookmarks.** When you add a bookmark to a book, a color-coded bookmark icon appears in the right margin. You can add multiple bookmarks to a book. Then, from anywhere in the book, tap the bookmark icon to go to the bookmarked page.

- **Highlights.** When you highlight text, it appears with a colored background.

- **Notes.** When you attach a note to text, you enter the text in a note pad that appears on top of the book page. A Note icon will display in the left margin. To show or hide the note, tap the icon.

- **Drawings.** When you add a drawing, a Drawing icon appears in the bottom-left corner of the page, and drawing tools appear across the bottom of the page. Draw by dragging your stylus.

- To see a list of a book’s annotations, including bookmarks, highlights, text notes, and drawings, tap **Annotations Index** on the book’s cover page. You can tap an entry in the list to go to the annotated page.
Removing a Book

- When you finish reading a book, you can delete it to conserve space on your Pocket PC Phone. If a copy of the book is stored on your desktop PC, you can download it again at any time.
- To remove a book from your Pocket PC Phone, tap and hold the title in the Library list, and then tap Delete on the pop-up menu.

Image Viewer

- **Image Viewer** allows you to conveniently view high-resolution JPEG and BMP pictures, whether you are at home or on the road.
- Download images to your PC, and then use ActiveSync to copy the files to your Pocket PC Phone. The images appear in Image Viewer, where you can tap them in the list to open them.
- Pictures can also be stored on a MMC or SD memory card to save memory on your Pocket PC Phone. Insert a card into the memory card slot and then copy or drag the pictures from your desktop PC to the My Documents directory on the memory card. (If the memory card does not have a My Documents directory, you must create one first).

Image Viewer is based in part on the work of the Independent JPEG group.

Transferring Images to your Pocket PC Phone

Pictures stored on your PC can be synchronized with Image Viewer on your Pocket PC Phone. Picture synchronization is not automatically selected in ActiveSync. For more information on synchronization, see ActiveSync Help on the desktop PC.

Changing your Image List Layout

You can choose to file your images in a list or as Viewer icons.
• To file images in a list tap View and then Details.

• To file images as Viewer icons tap View and then Large Icons.

**Viewing Images**

1. View any image stored on your Pocket PC Phone by tapping Start, Programs, Image Viewer and then Browse.

2. In Browse tap Find All or Change Folder – if you tap Change Folder a screen will appear listing the folders on your Pocket PC Phone.

3. Before you choose one you can select to view the actual size of the picture or to fit it to the screen. To do so tap View, Zoom, Best Fit or Actual Size.

**Deleting an Image**

Hold the stylus firmly on the file name of the picture you want to delete, and then select Delete from the pop-up menu.

**Refreshing All Images**

On the pop-up menu, tap Refresh and the file information on the picture list will be refreshed.

**Arranging Order**

If you are working in Details view, you can change the order in which the pictures are listed by tapping any of the following: file name, resolution, color numbers, file type, date or file size. The list will be sorted on the criteria selected.
Appendix A: Character Recognizer

Using Character Recognizer, you can write characters directly on your Pocket PC Phone screen with your stylus, just as you would on a piece of paper. The characters you write are translated into typed text. Use Character Recognizer anywhere you want to enter text - for example, to write a note or to fill in fields in a dialog box.

- The default writing mode for Character Recognizer is lowercase (Jot-compatible) mode. In this mode, you write characters in lowercase. The chart at the end of this appendix contains examples of how to write characters in lowercase mode.
- You can also choose to write in uppercase (Graffiti-compatible) mode. In this mode, you write characters in uppercase. If you prefer to write in uppercase mode, tap Uppercase Mode in Options on the input method menu. Whether a letter appears in uppercase or lowercase when it is converted to typed text depends on where in the input panel you write it - not on the mode you have selected.
- The Character Recognizer input panel is divided into three writing areas. Letters written in the left area (labeled ABC) create uppercase letters, and letters written in the middle area (labeled abc) create lowercase letters. Use the right area (labeled 123) for writing numbers, symbols, special characters and punctuation.

- The chart is a partial display of the characters you can write while in lowercase mode (the dot on each character is the starting point for writing). Remember that even though you write a letter in its lowercase form, the case of the text that is displayed depends on where you write the letter. For example, if you write a lowercase “a” in the ABC area, an uppercase “A” is displayed on the screen.

For more information on using Character Recognizer and for demos of all characters, tap on the Character Recognizer input panel.
Appendix B: Troubleshooting

Resetting the Pocket PC Phone and Clearing Memory

You can perform a soft reset or a full reset, depending on the situation. A full reset, in the sense that you will lose all data and any software you have installed yourself, is similar to reinstalling your operating system (OS) on your desktop PC. A soft reset is similar to restarting your desktop PC.

If your Pocket PC Phone responds slowly, stops responding or freezes, try soft resetting it. A soft reset causes the Pocket PC Phone to restart and re-adjust memory allocation. Unsaved data in open windows may be lost.

To perform a soft reset

- Use the stylus to press and hold the Reset button for about two seconds. (For details on finding soft reset, see “Chapter 2, Bottom Edge Components.”)

To perform a full reset

Warning: Clearing memory deletes all data and restores the Pocket PC Phone to its default settings. Programs installed at the factory remain, while data you have created and programs you have installed are erased.

1. Unscrew the stylus and use the smaller point of the top-half.

2. Press the battery switch once to turn it off, and then once more to turn it back on.

Use ActiveSync to keep a backup of your Pocket PC Phone data so that if you need to clear memory, you can restore the data on your Pocket PC Phone. For more information, see ActiveSync Help.
Battery loses power

When the battery is low, you will see a battery icon (issippi: main battery low,issippi: main battery very low) in the status bar of the screen, and a pop-up screen will tell you to recharge the battery as soon as possible. The battery is split into two portions: main battery and backup battery. When the main battery portion is discharged, your Pocket PC Phone will power off. However, the backup battery portion will preserve your data for 72 hrs. If the backup battery portion is discharged, you run the risk of losing the data on your Pocket PC Phone.

You want your Pocket PC Phone battery charge to last as long as possible, especially when you are on the road. Under normal conditions, you can get many hours of use from a single set of batteries or from a full charge. Here are a few tips to help you get the most from them.

**Use external power whenever possible**

Use the AC adapter to plug your Pocket PC Phone into external power whenever possible, especially when:
- Establishing a remote connection.
- Using the front light feature of your Pocket PC Phone display.
- Connecting to a PC.
- Letting the notification light flash for extended periods.

**Shorten auto suspend time**

While on battery power, your Pocket PC Phone automatically suspends operation if you have not touched the hardware buttons or used the stylus for a specified period. Maximize battery life by shortening the time. Tap \ and then **Settings**. On the **System** tab, tap **Power**, and then adjust the **On battery power** setting.

**To turn off sounds you do not need**

The Pocket PC Phone produces sounds in response to a number of events, such as warnings, appointments, screen taps and hardware button presses. To optimize battery life, turn off any sounds you do not need. Tap \ and then **Settings**. On the **Personal** tab, tap **Sounds & Notification** and clear check boxes on the **Volume** and **Notifications** tabs.

**To turn off notification light**

Tap \ and then **Settings**. On the **Personal** tab, tap **Sounds & Reminders**. On the **Reminders** tab, clear the **Flash light for** check box.

**If you forget your password**

If you forget your password, you will need to clear memory on the Pocket PC Phone. See Resetting the Pocket PC Phone and Clearing Memory earlier in this appendix.

**If you run out of phone memory**

Memory on your Pocket PC Phone is shared between storage memory and program memory. Storage memory is used to store the information you create and programs you install. Program memory is used to run programs on your Pocket PC Phone. Your Pocket PC Phone automatically manages the allocation between storage and program memory. However, in some situations, such as when memory is low, your Pocket PC Phone may not be able to automatically adjust the allocation. If you receive a message stating that storage or program memory is unavailable, try the following solutions.

**Finding Space in Storage Memory**

- Move data to a MMC/SD storage card.

  - Tap **Programs**, and then **File Explorer**. Tap and hold the file you want to move, and tap **Cut**. Browse to the My Documents folder in the storage card folder, tap **Edit** and then tap **Paste**. Files stored in folders other than My Documents, or stored in folders within folders in My Documents, may not show up in the list view of some programs. When using Notes, Pocket Word, or Pocket Excel, you can also move files by opening the item and tapping **Tools** or **Edit** and then **Rename/Move**.
• Move e-mail attachments. In Inbox, tap Tools and then Options. On the Storage tab, select Store attachments on storage card. All attachments are moved to the storage card, and new attachments are automatically stored on the storage card.

• Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save new items on the storage card. In the program, tap Tools and then Options.

• If you are copying files from your PC or another Pocket PC Phone to your Pocket PC Phone, try adjusting the slider in the Memory setting. Tap and then Settings. On the System tab, tap Memory and check whether the slider can be adjusted manually before copying files.

• Delete unnecessary files. Tap Programs and then File Explorer. Tap and hold the file, and then tap Delete on the pop-up menu. To find your larger files, tap and then Find. In the Type list, tap Larger than 64 KB, and then tap Go.

• In Internet Explorer options, delete all files and clear history. In Internet Explorer, tap Tools and then Options. Tap Delete Files and Clear History.

• Remove programs you no longer use. Tap and then Settings. On the System tab, tap Remove Programs. Tap the program you want to remove and then tap Remove.

• Clear program memory as described in the following section. This will free some program memory so that it can be allocated to storage memory.

Finding Space in Program Memory
• Stop programs you are not currently using. In most cases, programs automatically stop to free needed memory. However, in some situations, such as when confirmation dialog boxes are waiting for a user response, the program may not be able to automatically stop. To check the state of your active programs, tap and then Settings. On the System tab, tap Memory and then the Running Programs tab. Tap the program you want to view and then tap Activate. Close any open windows or messages and return the program to list view. If this does not work, you can stop the program manually. First, make sure that closing open items and returning the program to list view saves your work. Then, stop the program by tapping Stop or Stop All on the Running Programs tab.

• Clear storage memory as described in the preceding section. This will free some storage memory so that it can be allocated to program memory.

• Resetting your Pocket PC Phone can release the program memory. You can do it as described in Resetting the Pocket PC Phone and Clearing Memory earlier in this appendix.

Screen freezes or responds slowly
Reset your Pocket PC Phone. See Resetting the Pocket PC Phone and Clearing Memory earlier in this appendix.

Screen is blank
If your Pocket PC Phone does not respond when you briefly press the Power button, press and hold the button for a full second. If that does not work:
• Make sure your Smart Card door cover is closed and all expansion slots are secured.
• Plug the AC power into your Pocket PC Phone.
• Reset the Pocket PC Phone. See Resetting the Pocket PC Phone and Clearing Memory earlier in this appendix.

Screen is dark
Prolonged exposure to direct sunlight may cause your Pocket PC Phone screen to temporarily darken. This is normal for LCD screens and is not permanent.

Screen is hard to read
If you are having a hard time viewing a document in Notes, try changing the size of the view. To do this, tap a zoom percentage on the Tools menu. In Pocket Word and Pocket Excel, on the View menu, tap Zoom and then select a zoom percentage. In Pocket Internet Explorer, on the View menu, tap Text Size and then select a size.
If you are having a hard time viewing Pocket Outlook data, try enlarging the display font. To do this within Calendar, Tasks, or Contacts, tap Tools, then Options and then select Use large font.

**Inaccurate response to stylus taps**

Adjust the touch screen to respond more accurately to screen taps. Tap and then Settings. On the System tab, tap Screen and then Align Screen. Or press and hold Calendar button and then press Action to launch the screen tapping calibration process.

**Slow or no response**

Reset your Pocket PC Phone. See Resetting the Pocket PC Phone and Clearing Memory earlier in this appendix.

**Infrared (IR) connection problems**

If you are unable to use IR to transfer information, try the following:

- Transfer only one file or no more than 25 contact cards at a time.
- Line up the IR ports so that they are unobstructed and within close range.
- Make sure nothing is between the two IR ports.
- Adjust the room lighting. Some types of light interfere with IR connections. Try moving to a different location or turning off some lights.

**Phone connection problems**

If you have a problem using your phone, try the following:

- Make sure your wireless connection to your mobile service provider is switched on and the signal is unobstructed. (For more information see “Checking You Are Connected” in Chapter 4).
- Contact your mobile phone service provider for help.

**Internet connection problems**

The following connection problems may occur. Additional troubleshooting information is available in Connections Help on the Pocket PC Phone and ActiveSync Help on the desktop PC.

- Check you have set up and connected to an Internet Service Provider.
- Make sure your wireless connection to your mobile service provider is switched on and the signal is unobstructed (For more information, see “Checking You Are Connected” in Chapter 4).
- Verify with your Internet service provider that your user name and password are correct.
- Verify with your Internet service provider that the network you are trying to connect to is available, or try to connect to it from another PC.

**Network connection problems**

The following connection problems may occur. Additional troubleshooting information is available in Connections Help on the Pocket PC Phone and ActiveSync Help on the desktop PC.

- Make sure your wireless connection to your mobile service provider is switched on and the signal is unobstructed (For more information, see “Checking You Are Connected” in Chapter 4).
- Verify that you have added necessary server information. Tap and then Settings. On the Connections tab, tap Network Adapters. Most networks use DHCP, so you should not have to change these settings unless your network administrator instructs you to do so.
- If Network Connection is not listed as a connection method in the ActiveSync dialog box when starting synchronization, wait a few minutes and try again. Also, if synchronization does not start right away, the network is probably busy and it may take a minute for your Pocket PC Phone to connect to the network.
- Verify with your network administrator that your user name and password are correct.
- Verify with your network administrator that the network you are trying to connect to is available, or try to connect to it from another PC.
- You may need to change the Pocket PC Phone name if you are trying to connect to a network and cannot because another
Pocket PC Phone with the same name is already connected. To change the Pocket PC Phone name, tap Settings, and then System. On the System tab, tap About and then the Pocket PC Phone ID tab.

Cable and cradle connection problems

The following solutions may help if you encounter problems when connecting to your desktop PC. Additional troubleshooting information is available in Connections Help on the Pocket PC Phone and ActiveSync Help on the PC.

• Ensure the Pocket PC Phone is turned on.

• Ensure that you do not have any other active connections. Tap Today and then Disconnect.

• Ensure the cable is securely plugged into the COM port on the back of your desktop PC. Use the cable that came with the Pocket PC Phone without any extra cables or extenders attached.

• Plug the other end of the cable securely into the correct port on your Pocket PC Phone. If you are using a cradle, push your Pocket PC Phone securely into the cradle.
Appendix C: Regulatory Notices

Regulatory Agency Identification Numbers
For regulatory identification purposes your product is assigned a model number HTC 9500.
The following accessories have been evaluated for use with your Pocket PC Phone. Their assigned model numbers listed below can identify these approved accessories. To ensure continued reliable and safe operation of your Pocket PC Phone, use only the accessories listed below with your HTC 9500.

<table>
<thead>
<tr>
<th>Accessories</th>
<th>Model Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pocket PC Phone</td>
<td>HTC 9500</td>
</tr>
<tr>
<td>Cradle</td>
<td>HTC 9500</td>
</tr>
<tr>
<td>External Battery Pack</td>
<td>HTC 9500</td>
</tr>
<tr>
<td>Car Charger</td>
<td>HTC 9500</td>
</tr>
<tr>
<td>Headset</td>
<td>HTC 9500</td>
</tr>
<tr>
<td>SD card</td>
<td>HTC 9500</td>
</tr>
</tbody>
</table>

Note: This product is intended for use with certified Class 2, rated 5 V dc, minimum 1A power supply unit.

European Union Notice

Compliance with these directives implies conformity to the following European Norms (in brackets are the equivalent international standards):

- EN 60950 (IEC 60950) - Safety of Information Technology Equipment
- ETS 300 342-1 (June 1997) - Electromagnetic compatibility and Radio spectrum Matters (ERM); ElectroMagnetic Compatibility (EMC) for European digital cellular telecommunications system (GSM 900MHz and GSM 1900MHz); Part 1: Mobile and portable radio and ancillary equipment
- GSM11.10
- ANSI/IEEE C.95.1-1992- specific absorption rate in mobile phone emission condition for body health
- FCC part 15 and part 24
- prENV50166-2, 1995 for SAR
Important Safety Information

Retain and follow all product safety and operating instructions. Observe all warnings on the product and in the operating instructions.

To reduce the risk of bodily injury, electric shock, fire, and damage to the equipment observe the following precautions.

General Precautions

Heed service markings: Except as explained elsewhere in the Operating or Service documentation, do not service any product yourself. An authorized service technician or provider should do service needed on components inside these compartments.

Damage requiring service: Unplug the product from the electrical outlet and refer servicing to an authorized service technician or provider under the following conditions:

- Liquid has been spilled or an object has fallen into the product.
- The product has been exposed to rain or water.
- The product has been dropped or damaged.
- There are noticeable signs of overheating.
- The product does not operate normally when you follow the operating instructions.

Avoid hot areas: The product should be placed away from heat sources such as radiators, heat registers, stoves, or other products (including amplifiers) that produce heat.

Avoid wet areas: Never use the product in a wet location.

Avoid pushing objects into product: Never push objects of any kind into cabinet slots or other openings in the product. Slots and openings are provided for ventilation. These openings must not be blocked or covered.

Mounting Accessories: Do not use the product on an unstable table, cart, stand, tripod or bracket. Any mounting of the product should follow the manufacturer’s instructions, and should use a mounting accessory recommended by the manufacturer.

Avoid unstable mounting: Do not place the product with an unstable base.

Use product with approved equipment: This product should be used only with personal computers and options identified as suitable for use with your equipment.

Adjust the volume: Turn down the volume before using headphones or other audio Pocket PC Phones.

Cleaning: Unplug the product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning, but NEVER use water to clean a LCD screen.

Safety Precautions for Power Supply Unit

Use the correct external power source: A product should be operated only from the type of power source indicated on the electrical ratings label. If you are not sure of the type of power source required, consult your authorized service provider or local power company. For a product that operates from battery power or other sources, refer to the operating instructions that are included with the product.

Handle battery packs carefully: This product contains a Lithium Polymer battery. There is a risk of fire and burns if the battery pack is handled improperly. Do not attempt to open or service the battery pack. Do not disassemble, crush, puncture, short external contacts or circuits, dispose of in fire or water, or expose a battery pack to temperatures higher than 60°C (140°F).

WARNING: Danger of explosion if battery is incorrectly replaced. Replace only with specified batteries. Dispose of used batteries according to the local regulations or Reference Guide supplied with your product.
## Appendix D: Hardware Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDA module: Processor</td>
<td>Intel SA-1110 CPU</td>
</tr>
<tr>
<td>Memory</td>
<td>SDRAM 32MB/64MB; Flash ROM: 32MB</td>
</tr>
<tr>
<td>GSM/GPRS module</td>
<td>900/1900 MHz</td>
</tr>
<tr>
<td>LCD module</td>
<td>3.5” 240x320 pixels, 4096 colors reflection TFT.</td>
</tr>
<tr>
<td>Buttons</td>
<td>Four buttons (2 GSM and 2 Windows CE AP buttons - programmable); power and backlight control; navigation pad for scroll up, down, left, right and action; volume adjustment button.</td>
</tr>
<tr>
<td>Stylus</td>
<td>95mm, maximum diameter 5mm</td>
</tr>
<tr>
<td>Notification</td>
<td>One LED or Vibration motor for GSM and PDA for event standby alarm; charging.</td>
</tr>
<tr>
<td>Audio</td>
<td>Built in Microphone, speaker and buzzer; one earphone/microphone jack with stereo sound; MP3 stereo</td>
</tr>
<tr>
<td>Interface</td>
<td>Plug in Smart Card; feature connector (RS-232, USB and DC power); infrared IrDA SIR.</td>
</tr>
<tr>
<td>Power</td>
<td>Rechargeable battery Talk: 4 –5 hours; standby: 150 – 170 hours; PDA: 15-17 hours, Li-Polymer; 3.7V 1500 mAh; AC adapter 90-240VAC, 5V/2A 10W; built-in charger.</td>
</tr>
<tr>
<td>Accessories</td>
<td>AC adapter 100–240v 5A= 1V; USB cradle; earphone plug; service kit; protective pouch.</td>
</tr>
</tbody>
</table>
Appendix E: Icons

Phone

Phone off or out of network service - tap to turn on the phone.

Phone on or in network service - tap to turn off the phone.

Call Missed - tap to view the call(s) you missed, or tap and then tap Close to erase the icon.

E-mail or SMS notification - tap to view the SMS or E-mail not read, or tap Close to erase the icon.

Synchronization proceeding - the icon will disappear when synchronization is finished.

Send button - press to make a phone call.

End button - press to end a call.

Talk - tap to have a phone call in phone dialer.

Clear - tap to erase the number you input in phone dialer.

End - tap to end a call in phone dialer.

Erase - tap to erase the numbers you input one by one. Or tap and hold the icon to erase the whole number you input in phone dialer.

Notes - tap during a call to make a note for the particular call in phone dialer.

Speed Dial - tap to view a speed dial list, and speed dial a number in phone dialer.

The order in the speed dial list - tap to speed dial.

Call Log - tap to view the call you made/received in phone dialer.

Incoming call - notifies you it is an incoming call.

Outgoing call - notifies you it is an outgoing call.

Missed call - notifies you it is a call you missed.
Pocket PC

Start menu - tap to pull down the start menu.

System volume - tap to adjust the volume for both the phone and Pocket PC.

Power low - notifies you the battery is in the power low status.

Power very low - notifies you the battery is in the power very low status - recharge to avoid lost data.

Connection is active - the icon will disappear when the connection ends.

Synchronization proceeding - the icon will disappear when synchronization is finished.

Instant message notification - tap it to read the content of the instant message.

E-mail or SMS notification - tap to view unread SMS or E-mail, or tap and then tap Close to erase the icon.

Establishing the connection - the icon will disappear when the connection is established.

Icon room - if more notification icons need to be displayed than is room to display them, tap the icon to view all notification icons.

ActiveSync - synchronizes information between your Pocket PC Phone and PC.

Calendar - keeps track of your appointments and creates meeting requests.

Contacts - keeps track of your friends and colleagues.

Inbox - sends and receives e-mail/SMS messages.

Pocket Internet Explorer - browse Web and WAP sites, and download new programs and files from the Internet.

Notes - create handwritten or typed notes, drawings and recordings.

MS Reader - read e-Books on your Pocket PC Phone.

Image Viewer - view JPG and GIF formatted pictures on your Pocket PC Phone.

Tasks - keep track of your tasks.

Pocket Excel - create new workbooks or view and edit saved Excel workbooks.

Pocket Word - create new documents or view and edit saved MS Word documents.

MSN Messenger - send and receive instant messages with your MSN Messenger contacts.

Phone - make and receive calls, swap between calls and set up conference calling.

SD Backup - back up your Pocket PC Phone files to a SD card.

Phone Book - load contents of your Smart Card to your Pocket PC Phone and transfer to Contacts.
**Windows Media Player** - enable the multimedia function on your Pocket PC Phone.

**Buttons** - assign application programs to hardware buttons.

**Input** - set up the input portion of your Pocket PC Phone.

**Menu** - customize what appears on the menu, and enable a pop-up menu from the New button.

**Owner Information** - enter your personal contact information.

**Password** - limit access to your Pocket PC Phone.

**Phone** - set up the phone function of your wireless feature.

**Sound and notification** - set the notification type, event and volume.

**Today** - customize the look and the information that is displayed on the Today screen.

**Backlight** - customize the backlight on/off and brightness for power saving purposes.

**Clock** - change the time or set alarms.

**Microphone AGC** - enable/disable the microphone Automatic Gain Control (AGC).

**Power** - maximize battery life.

**Regional settings** - customize relative formats for the region you use.

**Remove programs** - remove some application programs not used frequently to save limited memory.

**Screen** - recalibrate the screen tapping and enable/disable the ClearType feature.